Rochester Institute of Technology

RIT Digital Institutional Repository

Books

2007

Test Targets 7.0: A Collaborative effort exploring the use of
scientific methods for color imaging and process control

Robert Chung
rycppr@rit.edu

Arvind Karthikeyan
Franz Sigg
Wuhui Liu

Fred Hsu

See next page for additional authors

Follow this and additional works at: https://repository.rit.edu/books

Recommended Citation

Chung, Robert, Arvind Karthikeyan, Franz Sigg, Wuhui Liu, Fred Hsu, and Steve Suffoletto, Test Targets 7.0,
A collaborative effort exploring the use of scientific methods for color imaging and process control.
Rochester, NY: RIT School of Media Sciences, 2007. https://scholarworks.rit.edu/books/72

This Full-Length Book is brought to you for free and open access by the RIT Libraries. For more information, please
contact repository@rit.edu.


https://repository.rit.edu/
https://repository.rit.edu/books
https://repository.rit.edu/books?utm_source=repository.rit.edu%2Fbooks%2F72&utm_medium=PDF&utm_campaign=PDFCoverPages
mailto:repository@rit.edu

Authors
Robert Chung, Arvind Karthikeyan, Franz Sigg, Wuhui Liu, Fred Hsu, and Steve Suffoletto

This full-length book is available at RIT Digital Institutional Repository: https://repository.rit.edu/books/72


https://repository.rit.edu/books/72

Test largets



Test Targets 7.0

A collaborative effort exploring the use of scientific methods for color
imaging and process control

RIT School of Print Media, November 2007



© Copyright 2007 School of Print Media, Rochester Institute of Technology

Printed at RIT in Rochester, New York, USA

Table of Contents

INtroduction, RODEIt CRUNG .......coouviiiiiiiiiit ettt i

Process Control

Implementing Process Color Printing by Colorimetry, Robert Chung .............cccccccecevciecnnnn. 7
Challenges in the Implementation of a Softproofing System, Arvind Karthikeyan .................. 17
Stability of an Inkjet Color Proofer, Wuhui Lits ............c.ccccooviiiiiiiiiiiiiiiiiiiiciicicceccee 25

Color Management Applications
Achieving Color Agreement: Evaluating the Options, Robert Chung, Wuhui Liu, Fred Hsu .... 35

Quality Assurance

Increasing Local Image Contrast, Franz Sigg ..........ccocceuiiiiiuiiiiiiiiiiieeieeeee e 45
Densitometric Gray Balance & Neutrality Determination, Steve Suffoletto ...............c.......... 51
Automated Test Wedge Generator, Franz Sigg ........ccccucuieeiiioieniiiiiieiiieiieeieeee e 60

Gallery of Visual Interest

Folded Panel in Design and Print Media Applications, Robert Chung ..........cccccccevvvevcuvenncne 64
Test Forms

Device Characterization Target ............cccoiviiiiiiiiiiiiiccicie e 74
Pictorial Reference IMages .........coouiiiiiiiiiiieiie e 75
SYNNETIC TAIGELS ..ottt ettt et et 76
Total Area Coverage Chart (TAC) ....cc.eeiiieiieiiieie ettt ettt 77
RIT Gray Balance Chart ........ccooouiiiiiiiii e 78
[T8.7/4-2005 RANAOM .....oiiiiiiiiiiiiiii i 79
[T8.7/4-2005 VISUAL ..eeiiiiiiieiite et 80
RIT Multicolor Gradient Chart .........c...cciiiiiiiiiii e 81
Colophon

Press RUN OrganiZers .......c.uiiiiiiiiiiiiiiiii i 82
The Test Targets 7.0 TRAM .....ccuiiiii ettt ettt ettt ettt ettt ettt e eete e eans 85



Test Targets 7.0

Introduction
Robert Chung

Test Targets was first created to use in my teaching six years ago and has been
under my tutelage all these years. It is my pleasure to provide you with an
overview of what Test Targets is all about.

Test Targets Serves RIT’s Print Curriculum

Test Targets is a culmination of teaching and learning that reflects quality and
analytic aspects of printing systems and their optimization. The creation of
the Test Targets publication is a total experience that reflects the innovation,
problem solving, and teamwork of the diverse team of faculty, staff, students, and
professionals responsible for its contents and production.

Test Targets holds a unique position within the RIT community because it
marks both the outcome of curriculum and collaboration as well as the starting
point of new learning and research as it plays a role in the coursework and
collaborative research to follow. The technical content of the publication is
referenced regularly in undergraduate and graduate classes focused on print
and production and image quality. The production of the annual publication
is discussed as a case study in coursework focused on workflow and project
planning.

The publication also serves as a connector between curricula and
communities, both inside and outside of RIT. The RIT library, Wallace Memorial
Library, preserves archived copies of the publication in its Digital Media Library
for the general RIT population to access. Hardcopies of the publication are
distributed directly to a growing number of scholars and professionals in the
field. The increased access to Test Targets has fostered new dialogues and spurred
conversations on topics of new learning, research, and opportunity.

Balancing Between Change and Tradition

With the presidential election coming up in 2008, we frequently hear candidates
talking about ‘change’ vs. ‘more of the same.” Given that change is essential,
change itself does not always lead to better outcome. On the other hand, ‘more
of the same’ or ‘tradition” is not necessarily a bad thing. ‘Change’ or ‘more of
the same’ also frequently surfaced when contemplating what to include in Test
Targets 7.0. Let us take a quick look at what we have in this edition.

Test Targets 7.0 contains three broad sections: Articles, Gallery of Visual
Interest (GVI), and Test Forms. Professor Wuhui Liu, a visiting scholar from Wuhan
University, reported the color stability of an Epson inkjet printer. | wrote a paper
on how to implement process color printing by colorimetry. Together, Professor
Liu, Fred Hsu, and | wrote a paper on achieving color agreement using different
color adjustment methods. Arvind Karthikeyan assessed the 30-inch Apple
Cinema Display monitor against ISO 12646 standards as a softproofing device.
Steve Suffoletto examined metrics for gray balance or neutrality determination in
the pressroom.

ii Introduction

Continuing on the notion of innovation and change, Franz Sigg describes
how increasing local image contrast can enhance the quality of newsprint,
which is a low or limited contrast printing system. In addition, he describes how
to generate a custom test wedge in the form of an EPS file using a Microsoft
Excel template that he has developed. The test wedge generator will be made
available at the RIT URL for the Color Management Systems Lab: http://www.rit.
edu/~gravure/CMS2007/.

The Gallery of Visual Interest, or GVI, has always been the most visual
and talked about section of Test Targets. To be visually interesting requires that
we seek new ideas and attempt new technologies that would make print media
exciting. In this issue, we explored the synergy between graphic design and print
with the idea of folded panels. The folded panel idea came to my attention when
[ visited Professor Tommie Nystrom of Linkdping University in Sweden. Produced
by digital presses, the Folded panels not only provide extra ‘real estate’ for printed
matter, but also support graphic design and communication in an interesting
manner. In addition, this edition of GVI showcases different screening and gloss
features available from the NexPress digital press. In short, we took an innovative
approach in seeking changes while preserving the value of Test Targets.

We have kept the Test Forms section very much the same as in previous
editions. After all, Test Forms is a collection of test elements with known properties.
They are designed to analyze specific behaviors of imaging devices. For example,
IT8.7/4 characterization target is a printer-profiling target. It is only useful when
the target is used as originally defined.

Moving Towards a Stronger Team with Greater Industry
Collaboration

School of Print Media (SPM) and Printing Applications Laboratory (PAL) are two
administrative units at RIT. The former focuses on credit-bearing college education.
The latter focuses on non-credit industry training and materials testing. The
intellectual challenge of content creation and do-it-right-the-first-time challenge
of print production have melded the two units and created a strong bond over the
years for the production of Test Targets.

Looking ahead, it is desirable to form a joint group between SPM and PAL
that meets regularly to steer the Test Targets direction, to attract students into the
project, and to provide resources and support in its development and production.
By having a stronger team, we can be more aggressive in setting agenda and in
instilling a more rigorous peer review process. While industry assistance grows
with every issue of Test Targets, such an organized approach would be a win-win
situation for all entities involved, students, supporters, and Test Targets.

Acknowledgments

| appreciate very much the collaboration between student, faculty, and staff
who have given their time and energy to conduct experiments, collect data, and
document major findings as well as those who are diligently involved in the
design and production of the publication. My kudos go to every author in the
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publication. If Test Targets 7.0 has a life, their contribution is the blood. I also want
to thank Dr. Patricia Sorce, my chairperson, for her continuous encouragement
and financial support of this project.

On the design side, a kudo goes to Drake Yang for his cover and other
graphic design and a kudo goes to Matt Rees for his page layout design. On the
editorial side, a special thank-you goes to Edline Chun for her final editing of all
texts. On the production side, a big thank-you goes to Sri Hemanth Prakhya for
his pagination and ‘traffic’ control. Sri and Sunchut Jongcharoensiri also assisted
me with the layout in the GVI section. On the quality control side, | want to
recognize Franz Sigg and Fred Hsu for their extraordinary efforts in making the
digital-to-print production workflow accurate and complete.

The PAL staff, under the leadership of Bill Garno, gave birth to Test Targets
7.0 with the cover printed by the Heidelberg sheet-fed press, body printed by Goss
Sunday 2000 web offset, and GVI printed by Kodak NexPress. Barb Giordano
coordinated the production schedule, including its binding and finishing by the
Riverside Group. We documented each of the three printing conditions in the
Press Run Organizers.

Dr. H.T. Tai of Eastman Kodak Company, a long-time friend of mine,
supported us with not only the screening technologies in the production of the
GVI, but also with valuable advice in the production of the panoramic images
with gloss features. He is truly a godsend.

I always appreciate the support of many companies who donated materials
or technologies that made the publication possible. Among them, Eric Johnson
of NewPage Corporation provided paper; Jason Clark of Superior Printing Inks
Corporation provided spot color inks; Kelly VandenBosch of X-Rite, Inc. provided
us the iSis spectro-densitometer; Bob McCurdy of GTI Graphic Technology, Inc.
provided the softproofing and hardcopy viewing station; Brian Rooney of Pantone,
Inc. provided a complete set of the color swatch library; Elie Khoury of Alwan
Color Expertise provided the link profiler; and Olaf Druemmer of Callas Software
GmbH provided the color management plug-in in Adobe Acrobat.

In Closing

Test Targets 7.0 serves RIT’s print curricular needs. Test Targets 7.0 is a reflection
of our collaboration between academe and industry. We would like to hear your
comments regarding how we are doing. Please send your e-mail messages to Bob
Chung at rycppr@rit.edu.
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Implementing Process Color Printing by
Colorimetry*

Robert Chung

Keywords

process color, colorimetry, densitometry, printing standards

Abstract

Standards-based printing is shifting from densitometry-based specifications to
colorimetry-based specifications. Similar to switching rules in the middle of the
game, this has caused confusions in pressrooms worldwide. This paper reviews
how standards-based printing began, describes underlying reasons for shifting
process control aims from densitometry to colorimetry, and addresses issues in
implementing colorimetry in the pressroom. Analysis of ink drawdown samples
and a sheet-fed lithographic press run were conducted to develop procedures
that would allow pressmen to adopt colorimetry in the pressroom. In doing so,
this paper also elaborates on how conformance to printing standards can be
verified by colorimetry.

Introduction

Print media has been an effective mass communication media for centuries.
Contents were printed and print quality was in the hands of the printer. As
printing technology developed, process color printing became possible to render
pictorial color images in the form of editorial contents and advertisements. Due
to market conditions and technology advancements, print buyers and content
creators started to demand color accuracy and consistency in printing.

Standards-based printing began evolving from craft to science.
Specifications Web Offset Publication (SWOP) was the first printing standard
developed in 1970s. Densitometric parameters, e.g., solid ink density and tonal
value increase (TVI) were used to specify aim points and tolerances for process
color printing. Portable densitometers were also developed in the 1970s to help
pressmen implement color control in the pressroom. The process of adopting
densitometerstoaid pressmen in ink key settings and maintaining color consistency
was a slow process. It took 15 years to transform the publication printing industry
from eyeball-based color adjustment to instrument-based control because print-
by-number involves not only capital investment, but also training and cultural
change in the pressroom.

Printing technology mainly addresses the output side of the graphic arts
industry. Print buyers need a total solution that encompasses content creation,
prepress, printing, and distribution. Digital color management became a solution

* Presented at the 34th International Research Conference of iarigai, Advances in Printing and
Media Technology, September 9-12, 2007, Grenoble, France: Printed with permission.
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that addresses the integration of prepress and press to make color portable and
predictable in the early 1990s. International Color Consortium (ICC) is the
standardization body that specifies the file format for look-up tables that describe
the relationship between the device color space and the device-independent
color space. The metrology for device-independent color space is colorimetry.

The effectiveness of color management depends on color repeatability of
the printing device. Device color repeatability begins from the color of the ink
in the can. ISO 2846 specifies colors of process inks by colorimetry. It became
evident that printing process control aims, such as ISO 12647, are shifted from
densitometry to colorimetry. Therefore, the integration of prepress and press by
means of color management is the main driver for implementing colorimetry in
the pressroom.

Objectives

Densitometry has proven to be effective for process control in the pressroom.
But density numbers do not correlate to colorimetric numbers directly. Thus, the
issue at hand is how to apply colorimetry in the pressroom. There are four issues:
(1) how to verify ink, (2) how to achieve press make-ready, (3) how to exercise
process control, and (4) how to verify printing conformance by colorimetry.

Experimental

A pressman has to place the right amount of process color (CMYK) inks in register
with one another on the substrate during the press make-ready. He also has to
maintain the control of the press run so that all products printed conform to
colorimetric requirements. This paper addresses that: (1) the correct inks are used,
(2) the correct amount of ink is printed, (3) color control is maintained throughout
the press run, and (4) color quality assurance is documented colorimetrically.

Verifying Ink

How does a pressman know he uses the correct process color inks to begin with?
Process color inks are specified in ISO 2846-1 (ISO, 2006) and ISO 12647-2 (ISO,
2004). In this case, colorimetric values (L*/a*/b*) of CMYK solids are specified
as K: 16/0/0; C: 54/-36/-49, M: 46/72/-5, and Y: 88/-6/90. Instead of sending
inks to a laboratory, we verify the correctness of process inks by ink drawdown
with a grind gauge block on a Little Joe proofer with inks supplied by Kohl &
Madden. A single impression from the grind gauge block produces a range of ink
film thicknesses. Color measurements were made at various ink film thicknesses.
Color differences were calculated relative to the I1SO specified aim points. SO
12647-2 also specifies that deviation of CMYK solids should be less than 5 AE.

Conforming to Colorimetric Aims

We organized a press run with the following equipment, materials and procedures.
From the input side, a customized test form was used for the press run. As shown
in Figure 1, the test form can be used for calibration, press capability study and
characterization.

8 Implementing Process Color Printing by Colorimetry

The Creo Prinergy 3 CTP system was used to produce a set of linear plates
at 170 Ipi AM screening. A 6-color Heidelberg Speedmaster 74 sheet-fed offset
press was used to print the test form on Sappi Lustro, Grade 1 coated paper, at
the speed of 8,000 impressions per hour. The printing sequence for the 6-color
press was blank-blank-K-C-M-Y-aqueous coating. Because of the use of aqueous
coating, press sheets were delivered dry and color measurement can be done
without delay. We measured color control bars, located at the perimeter of the
test form, to set ink keys.

S omn esuemt -
. o
i ‘
. .

Figure 1: Test form printed in the first press run

In order to print by colorimetry, we used the IntelliTrax, a scanning
spectro-densitometer from X-Rite, capable of measuring multiple color control
patches width-wise in density and color. Any color measurement system capable
of providing densitometric and colorimetric values must collect spectral data
from the press sheets and compute density and color by formulation.

Solid ink densities of K: 1.69, C: 1.45, M: 1.52, Y: 1.00 were initially
set using the X-Rite IntelliTrax scanning spectro-densitometer as the aim points
(Figure 2). Press sheet densities were converted to CIELAB values in IntelliTrax and
compared to ISO 12647-2 colorimetric aim points. Densities that correspond to
the smallest AE for each of the CMYK keys were selected as the new aim points.
In other words, pressmen are able to use familiar density for initial ink setting and
ink key adjustments while conforming to colorimetric specifications.

Figure 2: Spatial uniformity across the sheet as displayed by IntelliTrax

Implementing Process Color Printing by Colorimetry 9
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Controlling Color

When spectral reflectance data are collected, we can compute Status T (D)
density per CGATS.4. We can compute spectral (D, ) density at the wavelength
having the maximum light absorption. As shown in Figure 3, the wavelength
with the maximum absorption for cyan ink is at 630 nm; the wavelength of the
magenta ink is at 570 nm; and the wavelength of the yellow ink is at 430 nm.
We can also compute metric chroma (C*) from the spectral data per CGATS.5.
The question we want to answer is, “Which metric provides the best signal for

detecting process change or drift?”

1.0

0.9

0.8

0.7

0.6
Cyan

0.5

Magenta

Reflectance

Yellow

0.4
0.3

0.1

0.0
400 420 440 460 480 500 520 540 560 580 600 620 640 660 680 700

Wavelength
Figure 3: Spectral reflectance curves of process inks

In this study, we answer the above question by (1) selecting an ink film
thickness (IFT) from the drawdown sample that matches the colorimetric aim
point closest as the new reference, (2) calculating AD,, AD__, and AC* between
the new reference and a range of ink film thickness of interest, and (3) studying
the linearity and magnitude of change for each of the three metrics.

Assuring Process Quality

Printing specifications only provide aim points and tolerances. Press make-ready
only provides evidence of initial conformance. Neither the specification nor the
make-ready stipulates the spatial uniformity and the temporal consistency of the
entire press run. In this study, we measure a pre-determined CMY chromatic gray
patch over the width of the OK press sheet and press sheets sampled over time,
respectively, to document the uniformity and the stability of the press run.

Results and Discussions

Below are results with discussions relative to major findings and experiences
gained in ink verification, press make-ready, process control, and press run
quality assurance based on colorimetric analyses.

10 Implementing Process Color Printing by Colorimetry

Ink Verification

Figure 4 shows color difference as a function of relative ink film thickness. We
collected multiple measurements from the drawdown sample plus trend lines in
order to smooth out the noise. Notice that AE values at the ink film thickness at
5.5 relative IFT are less than the allotted tolerance of 5 AE for all three inks. This
provides evidence of ink conformance.

Even though we did not know the exact ink film thickness, we know that
the grind gauge block indicating the ink film at 5.5 um has been split twice. The
first ink split is between the ink in the gauge and the blanket; and the second ink
split is between the ink on the blanket and the paper. Assuming that the ink split
ratio is 45:55, the resulting ink film thickness is 5.5 x 0.45 x 0.45 or about one

um.

AE_Magenta
AE_Cyan
AE_Yellow
Tol.

3 4 5 6 7 8
Relative IFT

Figure 4: Color difference as a function of relative ink film thickness

Conformance to ink specification is the first step in implementing
printing process control by colorimetry. Measuring ink drawdown samples
with a spectrophotometer and the prescribed ink verification method in-house
encourages us. We can extend the ink verification method to verifying spot color
accuracy prior to the press run.

Colorimetric Conformance

Putting the correct amount of process inks quickly and accurately is the goal
of press make-ready. ISO 12647-2 stipulates a window of 5AE for CMYK solid
plus RGB overprints as the conformance rule. As shown in Table 1, all solid
ink patches, except the (M + C) blue overprint, are in conformance. Achieving
correct overprint color is a printability issue, e.g., adjusting ink sequence or ink
tack. The tolerance of 5 AE on primary chromatic inks may be used strategically
to encourage conformance of two-color overprint RGB colors.

Implementing Process Color Printing by Colorimetry 11
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Table 1: Colorimetric conformance of process color printing

ID Location K (o} M Y AEab
1 Al 0 100 0 0 1.8
2 A2 0 0 100 0 2.5
3 A3 0 0 0 100 4.1
4 0 100 100 0 7.8
5 0 100 0 100 2.1
6 0 0 100 100 4.3

25 B12 100 0 0 0 3.1

In addition, current ISO 12647-2 also stipulates that tonal value increase (TVI) of
each of the tonal ramps be conformed. TVI, traditionally defined densitometrically,
has been redefined from using tristimulus values in ISO 12647-1 (ISO, 2004). We
find the TVI aspect of the printing standard confusing, adding no value, and is
difficult to implement.

Instead of using the seven solid ink patches and TVI as conformance
criteria, we propose the use of metric chroma (C*) to calibrate tonal ramps of
CMY via transfer curves. Figure 5 shows the magenta gradation in terms of C*
between the initial press run and the ISO 12647-2. For the black printer, Darkness
(100 — L*) can be used to calibrate the black ramp.

100

90+ ISO 12647-2_Magenta
80+ —o6— Linear_Ave_Magenta
70
601

C* 501

40+
30
20
10+

0 10 20 30 40 50 60 70 80 90 100
% Digital dot area

Figure 5: Magenta gradation in terms of C* (left)

To answer the question of colorimetric conformance, we compare a
significantly larger number of color patches instead of the seven solid ink patches
as specified in the current ISO 12647-2 standard. TVI should be eliminated from
being a part of the standards. This is because TVI is a calibration issue, and not a
conformance issue.

As an example, color differences of the 1T8.7/3 basic data (182 patches)
between the OK sheet and that from FOGRA39 where ISO 12647-2 aim points
are compared. Figure 6 shows the CRF of AE between the two data sets. As a
rule of thumb, process conformance threshold (the gray dotted line) is when the
median AE is 3, the 90 percent tile AE is 6, and the maximum AE is 12 (Chung,
2001). In Figure 6, the median AE is at 4 that exceeds the conformance threshold.

12 Implementing Process Color Printing by Colorimetry

This is where printing conformance just missed out; color image differences are
visually noticeable if press sheet were compared with the standard press sheet.

1.0
09 | at’
0.8 |
0.7
206 |
B 05|
[<}
@ 04} /
0.3
0.2 Process Conformance
0.1 | « 1SO 12647-2 vs. Linear_Ave
0.0 Lot ‘ ‘ ‘ ‘ ‘ ‘
0 2 4 6 8 10 12 14 16

AEab

Figure 6: CRF of AE based on IT8.7/3 basic

Process Control Metrics

Regarding the choice of metric for printing process control, Figure 7 is graph of
AD, AD,,, and AC* as a function of AIFT for cyan ink. Here, both status T and
spectral density show linear responses to changes in cyan ink film thickness.
On the other hand, metric chroma (C*) is only sensitive to changes in low cyan
IFT region. Thus, status T density and the spectral density, computed from the
reflectance at the wavelength of 630 nm, are the metrics of choice for cyan inking
control.

10 0.5

AC*

6 7 8
Relative IFT (Cyan)

Figure 7: Three process control metrics in detecting changes in cyan ink film thickness

Figure 8 is graph of AD,, AD,, , and AC* as a function of AIFT for magenta
ink. Here, all three metrics are linear and behave similarly to changes in magenta
ink film thickness. Thus, any one of the three metrics will be useful for magenta
inking control.

Implementing Process Color Printing by Colorimetry 13

Test Targets 7.0



Test Targets 7.0

10 0.5
8 104

-10 -0.5
3 4 5 6 7 8
Relative IFT (Magenta)

Figure 8: Three process control metrics in detecting changes in magenta ink film
thickness

Figure 9 is graph of AD,, AD,, , and AC* as a function of AIFT for yellow
ink. Here, all three metrics are linear to changes in yellow ink film thickness. But,
the slope of the spectral density of yellow ink is noticeably higher than that of the
status T density. In addition, metric chroma has the largest change in yellow ink
in comparison to the same range of AIFT in cyan and magenta inks. Thus, status
T density is the least useful metric for controlling yellow inking.

10 0.5
8 0.4
6 +0.3
4 0.2
2 +0.1
AC* 0 0.0 AD
-2 +-0.1
-4 +-0.2
-6 +-0.3
-8 +-04
-10 -0.5

3 4 5 6 7 8
Relative IFT (Yellow)

Figure 9: Three process control metrics in detecting changes in yellow ink film thickness

By judging from Figure 7 to 9, there is no single metric that demonstrates
the best sensitivity and linearity over the ink film thickness of interest for all
three chromatic process inks. If process control is implemented in a closed-loop
environment, either spectral density or different metrics may be used without
human intervention.

14 Implementing Process Color Printing by Colorimetry

Printing Quality Assurance

Instead of assuming that inking is uniform across the sheet, we can investigate the
spatial uniformity of the printing system. The spread of the data from its average
can then be compared with the tolerance. In this case, we measured a chromatic
gray bar plus a black tint across the sheet relative to its average (Figure 10).
Notice that there is larger variation at either edge of the sheet. The data could
have been removed from the analysis if this is the trim or non-image area of the
sheet. While ISO 12647-2 specifies that variation of CMYK solids should be less
than 4 AE, the spatial uniformity of the printing system, based on 3-color neutrals
or black tints, is around 2 AE units.

10
9 ]
8 width 3C Overprint
7 1 — width 50% K
6 4
AE 5 |
4]
) VAN p
1 AN
: A\j % A
0

1 11 13 15 17 19 21 23 25 27 29
Distance Across Sheet

Figure 10: Spatial uniformity as assessed by 3-color gray and black tint

Instead of assuming that process does not drift after its make-ready, we
investigate how to document the temporal consistency of the press run. Quality
assurance of a press run begins with sampling and measuring multiple press
sheets collected over time. We can depict the temporal consistency of a press run
by depicting the colorimetric variation of a chromatic gray patch. If the chromatic
gray is pre-determined, e.g., 75C, 63M, and 60Y, the spread of the data points in
a*b* diagram as shown in Figure 11, may be off-centered. In this case, the tighter
the spread is, the more consistent the printing process is.

n

A Sample

O =~ N w b

>
'
R

b*

Figure 11. Temporal consistency of a chromatic gray patch

Implementing Process Color Printing by Colorimetry 15
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Conclusions

Density-based printing standards and using densitometry in the pressroom
have facilitated color consistency since 1970s. As the demand for colorimetric
accuracy and consistency in process color printing continues, it is inevitable that
CIELAB-based printing standards will become the norm. Not only densitometers
are replaced by spectral-based color measurement devices, all density-based
specifications, including TVI, should be replaced by colorimetric parameters.

We explored the use of colorimetry for ink verification. Since density only
specifies ink amount and not color, colorimetry is here to stay. We explored the
use of colorimetry for achieving printing aims. Since printing aims are specified
colorimetrically, colorimetry is essential forimplementing standard-based printing.
In addition, the knowledge of the prepress adjustment and the knowledge of the
press control are essential to achieve closer printing conformance.

We explored three metrics (status T density, spectral density, and metric
chroma) as process control parameters. We did not find a single metric suitable
for monitoring all three chromatic process inks significantly better than other
metrics. Finally, we looked at how a press run may be certified to assure its spatial
uniformity and temporal consistency with the use of colorimetry. The results have
been encouraging. More work and user feedback are necessary in order to make
the transition from densitometry to colorimetry in the pressroom.
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Challenges in the Implementation of a
Softproofing System

Arvind Karthikeyan

Keywords

softproofing, calibration, standards, uniformity, colorimetry

Abstract

One of the latest advancements in the confluence of computers and the print
industry is softproofing. Softproofing involves the use of calibrated and capable
monitors to accurately display the proofs. Softproofing enables the display of the
proofs on calibrated monitors at remote locations. This paper aims at providing
the reader a better understanding of a softproofing system by reviewing /SO
12646:2002 Graphic technology — Displays for colour proofing — Characteristics
and viewing conditions and testing the conformance of 30-inch Apple Cinema
Display to such specifications. Performance issues such as spatial uniformity and
the decay in the brightness levels of the Apple display are investigated. The article
also provides a standard operating procedure (SOP) for using the softproofing set
up to get the best possible results.

Introduction

Softproofing equipment is the latest addition to the state of the art facilities at the
Color Measurement Lab, School of Print Media, Rochester Institute of Technology.
The presence of this equipment has opened doors to further research and a better
understanding of the softproofing industry. For all further research in this area,
the devices have to be calibrated and the characteristics understood. The article
will focus on the requirements for a softproofing system and the challenges in the
implementation.

For any new technology to be implemented and studied, it should be
compared with some form of standard. The standard will serve as a benchmark
and help in the development of an operating procedure to get the best out of the
system at hand. In the case of softproofing, the standard that is to be followed is ISO
12646:2002 Graphic technology — Displays for colour proofing — Characteristics
and viewing conditions. The standard spells out the hardware requirements for
the softproofing system and the calibration procedures that are to be followed.

Key points of ISO 12646

The following paragraphs summarize the contents of ISO 12646 standard.
Various aspects spelled out by the standard such as requirements, calibration,
color gamut, and inter-site calibration are explained.
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Initial assumptions

ISO standards have been developed for a CRT (Cathode Ray Tube)- based system,
which acts as the display medium utilized for softproofing. The CRT-based system
is now replaced by the LCD (Liquid Crystal Display)- based system that is devoid
of problems such as flicker and opto-electronic convergence (the convergence of
the light from the components of a LCD system that transfers electrical signal into
light). ISO 12646 specifies the minimum requirements for the display devices that
are to be used in softproofing in terms of uniformity, convergence, refresh rate,
size, and spatial resolution. The standard specifies that some of the requirements
specified are subject to continuous improvement and hence this represents just
the minimum requirements.

The standard also specifies that it does not include the specifications that define
the conversion of the data from the digital file to display even in the best of
display devices.

The standard begins by describing the scope of the standard and the areas
where it could be employed. The definitions of all the terms that are employed in
the standards are also given upfront. Terms such as uniformity, convergence, opto
electronic transfer function, and refresh rate are defined in this section.

Requirements

ISO 12646 then describes the minimum requirements for a softproofing display.
The resolution of the display device used should be more than 1280 x 1024
pixels. The minimum size of the display device (17” diagonal) and the refresh rate
(80 Hz) are also specified in this section.

The requirements for other parameters such as uniformity, geometric
accuracy and convergence are also specified. These standards apply to a smaller
extent to LCD. The specifications of the 30-inch Apple Cinema Display meet all the
above requirements (www.apple.com/displays). The specification for the ambient
illumination pertains to all types of monitor displays and is worth mentioning.
The level of illumination in the surroundings should not be more than the 10% of
the maximum illumination of the monitor. The standard also specifies that D50
lighting be used for the surrounding in the softproofing area.

The chromaticity and the luminance of the black and the white points
of the display device are specified in the standard. The LCD-based system that
is widely used now has only the brightness point that can be adjusted. The
brightness specifies the luminance of the monitor, which can describe the display
range of the monitor. The gamma of the monitor/LCD that describes the range of
the display device is also specified in the standards.

The standard specifies the test methods that can be used to check for the
requirements of the display device. For example, the standard provides a test chart
model that can be used to check for the resolution of the display device. The chart
can also be used to check for the uniformity of the monitor used. This uniformity
problem exists in a LCD system and hence has to be paid attention to. The test
method specifies that the uniformity of the display device is measured at 9 points
in the display using a radiometer or an X-Rite Eye-One tristimulus colorimeter,
of known specifications. The standard also specifies that the uniformity test is
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performed for the display device when it displays white, gray, and black images.
The uniformity of the display device, after proper calibration, gives an idea of
the spatial variation in the displayed image across the monitor. For the sake of
softproofing it is always advisable to have a very high uniformity.

Displaying a test chart with vertical and horizontal lines of 2-pixel width
will help to check the geometric accuracy of the display device. If the display is
accurate, the lines should appear continuous and straight. The lines displayed
are checked for any abnormalities as it can indicate geometric irregularities. The
luminescences of the white and black points are also tested for. The measurements
are made using a radiometer or a tristimulus colorimeter at the centre of the
screen. The white point has to be measured with the screen displaying the
maximum digital value in each channel (255 in all the 3 channels) and the black
point with no digital count in all the 3 channels.

It can be seen that the equipment for the softproofing system is available
in most printing companies (with the exception of Eye-One Pro). The only
investment in this case would be the monitors and the booths for viewing the
samples.

Calibration

The calibration and characterization part of the standard states that the images in
different formats must be converted to the format that the display system can show
without problems. The conversion, if needed, should be effected using a color
management system. The standard again states that most of the specifications that
are given are not necessary for a LCD-based system, as it is comparatively more
standard and devoid of most of the problems of the CRT-based systems.

The standard specifies that all the images that are displayed in the
softproofing device should have a white border of 1 inch surrounding it on all
sides. The standard again states the importance of using the proper ambient lighting
in the viewing area. The standard also states that the image that is displayed in the
softproofing device has to have the profile of the device it is simulating and the
profile of the monitor applied to it.

Color gamut

The standard states that the gamut of the display device must fully cover/enclose
the gamut of the device we are trying to simulate. The standard spells out the steps
involved in determining the gamut of both the print sample and the monitor. After
the gamut boundaries are marked approximately, the standard then describes
the method of calculating the chromaticity coordinates, i.e., x and y, L*, C* and
hue angle h. The standard also mentions that the chromaticity coordinates of the
monitor display be calculated. The standard then describes the test where each
hue angle colors are simulated in the monitor to see if the display of the monitor
covers all those colors that are reproducible in the print medium. This is done
because there are some colors in print that cannot be displayed in the monitor.
The standard also hints that the display devices used for softproofing have to
calibrated from time to time to account for changes that happen with the passage
of time.
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Inter-site calibration

When a softproofing system is set up, the customer should be able to look at the
proofs and approve them from a remote location. The standard describes the kind
of system that is required for this case: the devices used for softproofing must be
calibrated and should be of comparable quality. The standard also recommends
the use of ISO 12641 target (refer to Figures 1a, 1b, and 2) for the calibration of

the display devices.
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Figure 1b: Layout of resolution targets  Figure 2: Positions for uniformity measurement

Figures 1 and 2 show the ISO 12646 prescribed test target to be used. The
condition of the display device could also be checked by displaying a known value
of color, using a spectrophotometer to measure it, and finding the deviation, if
any. The monitor is in an acceptable working condition if the AE (1974) between
the known value of color displayed and that, which is measured, is less than 2.

Challenges in softproofing

Challenges in implementation of softproofing involve studying the decay in the
brightness of the monitor, in order to be able to predict when the monitor will
neither display the right colors nor have spatial uniformity across the monitor.
The parameters, the methodology, and the results are discussed below.

Luminance decay

It is documented in all the resources for softproofing that the luminance level of
the monitor decays over a period of time and the operating range of the monitor
should be kept below the maximum luminance of the monitor at any given
point. To study the decay in the luminance of the 30-inch Apple Cinema Display
monitor, calibration was performed over a period of time and the luminance
level after each calibration procedure was noted. The calibration results were
saved with the date of the calibration. It was found that the luminance level of
the display decayed from 294 to 265-candela/ m? over a period of a month. The
measurements and the calibration routine were performed every day for the first 2
weeks and after the luminance stabilized once every 3 days. The brightness of the
display is designated in units of cd/m?* (candela/meter?). However the conversion
tables indicate that the relation between lumens and candela/ meter2 is 1:1. The

terms and the values are interchangeable.
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Figure 3: Luminance Decay of the 30-inch Apple Cinema Display

From the results reported in Figure 3, it is evident that the LCD display
needs to be calibrated and checked for the brightness from time to time. It was
observed that the LCD display deteriorated rapidly in the beginning and later
stabilized at 265-270 cd/m?. It is important to calibrate and check the luminance
decay in the display until it stabilizes. Once this stable period is reached
calibration could be performed once a week. In the case of remote softproofing,
it is imperative that the lowest luminance of the displays in the proofing is used

for as the operating value.

Spatial Uniformity

Spatial uniformity is one of the factors of major concern in the softproofing industry.
We had qualms about the uniformity across the monitor. The changes across the
Apple 30-inch monitor are not clearly visible when an image is displayed and
hence it demands the design of a test target to check for the spatial uniformity.
The best method to check for the uniformity of the display is to use a uniform
color patch as a test target (of size equal to the size of the monitor) and display
the same in remote director. The color that is chosen for this is a L50 color with
the a and b values as 0. This color is made into a background file of the size of
the display and is displayed.

Measurements of the luminance at various points in the display could be
made with the use of the Eye-One Pro, a popular hand-held colorimeter form
X-Rite (GretagMacbeth). The software that is used for the measurement of the
luminance is Eye-One Share. The software allows for the measurement of the
luminance and the color temperature of the ambient lighting and the display. The
luminance was measured at 12 different points in the display and was tabulated. It
was found that there was a great difference in the luminance of the display across
the monitor. The experiment was repeated 5 times and the values measured were

tabulated.
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Spatial Uniformity Plot

i 2
Luminence of Neutral Gray in cd/m

Figure 4: Spatial uniformity plotted (lumen vs. position)

The measurements, as shown in Figure 4, with the label RD indicate those
that were measured inside the display of Remote Director, the remote softproofing
software developed by ICS (Integrated Color Solutions). Remote Director alters
the display property of the display and hence it is beneficial to study the behavior
of the display when Remote Director is running. It is observed that the values of
the measurements made inside Remote Director are less than the measurements
made on the display, as Remote Director uses a different number system to
represent the luminance. For the sake of measuring the spatial uniformity of the
display a test form was designed to fit the screen of the display. The color that was
filled in the test form was a neutral gray (L= 50 a=0 b=0)

The measurements were also made displaying the test using Adobe
Photoshop and the plots labeled “mon” (used to represent the readings made on
the LCD display) indicate them. It can be seen that the luminance measured across
the display varies irrespective of using Remote Director or not. This indicates that
there is a lack of spatial uniformity in the display device used.

From the tests that were performed on the Apple monitor, it is evident that
there is a problem with spatial uniformity as far as the displays are concerned.
The lack of spatial uniformity can pose a serious threat to the very concept of
softproofing. Variation in color across the display can greatly disrupt the perception
of color. There is no way to address this problem from the hardware (display)
as such. There is software available that can be used to solve this problem of
spatial non-uniformity. The software that is a part of Remote Director divides the
screen into 64 or 128 subsections and calculated the intensity of the light coming
from each of the subsections. The software then modulates the intensity across
the display so that all positions only emit the lowest intensity, thereby ensuring
uniform intensity across the Apple display (www.icscolor.com).

Color Gamut

Another area of concern in using a 30-inch Apple Cinema Display monitor for
proofing is the gamut of colors the monitor can display. It is imperative to check
the color gamut of the device to see if it encompasses a standard profile like that
of ISO 12647-2. This verification requires the creation of a profile for the display.

22 Challenges in the Implementation of a Softproofing System

The profile of the display is created using ProfileMaker 5.0, a popular profiling
software from X-Rite, and is saved with the appropriate name. The profile is
opened in ColorThink Pro version 3.0, a product of CHROMiX that helps in
analyzing profiles, and is compared to that of GRACoL Profile (2006), based on

ISO 12467-2, in the 3-D plot tool. Figure 5 and 6 are screen shots obtained when
they were plotted.

Figure 5: View 1 - Comparison of the color gamut of GRACoL and the display

Figure 6: View 2 - Comparison of the color gamut of GRACoL and the display

The smooth shape represents the gamut of GRACoL (2006) profile whereas
the wireframe represents the gamut of the Apple 30-inch display. It is evident
from Figures 5 and 6 that the display is not capable of representing colors that
occur near the green end of the spectrum. This is a problem with the display and
hence proves to be a stumbling block in softproofing colors in that region.

Inferences and recommendations

The study of the decay in luminance indicates that the display is likely to
deteriorate over a period of time. This implies that the display has to be calibrated
from time to time to check for the luminance range and the luminance range of

Challenges in the Implementation of a Softproofing System 23

Test Targets 7.0



Test Targets 7.0

Remote Director (if used) should be set accordingly. After the luminance of the
display has stabilized, the reference luminance range where the system is to
operate could be set. The monitor that was studied seemed to stabilize at around
265 cd/ m? and hence the max luminance of operation was fixed at 250 cd/ m?.

The study of the spatial uniformity indicates variations in the luminance
of the display. This is attributed to the display and cannot be eliminated at the
hardware level. However the software developed by ICS will go a long way in
addressing the problem of spatial uniformity.

The comparison of the gamut of the display and a reference printing
condition such as GRACoL shows that there are a few colors in the gamut of
GRACoL that the 30-inch Cinema Display cannot display, such as some cyans.

Another issue with the use of LCD displays for softproofing is the limitation
in the viewing angle. The images displayed on the monitor start to look different
when they are viewed at an angle more than 20 degrees from the centre of the
screen.

Taking into consideration both the advantages and the disadvantages
of the LCD display discussed above we can say that Apple’s 30-inch Cinema
Display could be used as a part of softproofing process if properly calibrated and
monitored.
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Stability of an Inkjet Color Proofer
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Abstract

A good color-proofing device depends on its stability and color management
applied. If a color proofer is not stable, its ICC profile will not reflect its color
characteristics over time. In this study, we tested the stability of an Epson Stylus
Pro 4000 Inkjet printer by outputting 30 color samples over a period of three
months. We analyzed the proofer stability in terms of density of solids, TVI of
50% tints, and metric chroma of a near-neutral color patch. We found that the
stability of Epson Stylus Pro 4000 is acceptable as a color-proofing device using
GRACoL tolerance as a guideline. Its color shift, although measurable, is not
noticeable when serving as a color proof.

Introduction

Device stability refers to the ability of a device to produce the same
outcome when using known input and consumables over a period of time. In
color proofing, the stability of the proofer determines its color consistency within
a production and from run to run.

Device accuracy, however, refers to the ability of the device to produce
the desired outcome as dictated by an external aim point. In color proofing, the
accuracy of a proofer depends on both how well it is calibrated and controlled
such that the average of all outcomes agrees with the aim point.

Both device stability and accuracy are important in color proofing. This
is because a color proof is a simulation of the press results before the job is
printed.

When selecting a color proofing device, the device stability should be
addressed before the device accuracy. This is because stability is an inherent
characteristic of the device and accuracy can be addressed by calibration and
the use of ICC profiles. This research focuses mainly on device stability. Thus,
the objective of this research is to devise a method to test proofer stability and to
assess the proofing performance.

Literature Review

Variability exists everywhere. Some are common-caused and others are
special-caused. Common-caused variations are inherent and we have to live with.
But, special-caused variation might be removed. Common-caused variations can
come from many sources, including materials, operations, and environments.
In the case of a color proofer, material-related factors include paper, inks, inkjet
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head, etc. Operational factors include variation as a result of ink replacement and
cleanliness of inkjet head. Environmental factors include ambient temperature,
relative humidity, etc.

When assessing stability of a color proofer, the best we can do is to
not include any special-caused variation. Measuring instrument stability can
contribute significantly to the device stability, as can the condition (age) of the
inkjet sample.

Chung and Shimamura (2001) studied repeatability of a scanning
spectrophotometer color measuring instrument (Spectrolino SpectroScan). A
Cumulative Relative Frequency (CRF) curve between two sets of measurements
made from the same press sheet was generated. They found a AE of 0.19 at the
50 percentile, a AE of 0.40 at the 90 percentile, and a AE of 0.64 for all 182 color
patches in the IT8.7/3 basic target.

Chan, Chung, and Cheung (2000) performed an output sample stability
test. In their study, an IT8.7/3 basic target sample printed by EPSON SC300 was
measured seven times in 24 hours. Delta E of the four process color ramps, paper,
and an average (based on all 182 patches of IT8.7/3basic) were calculated based
on the first measurement. They found that there was a sufficient delta E difference
in the first two hours, and a minimal between two to eight hours.

Chung (2003) exhibited a method to test process variation and deviation
of an offset press. CMYK solid ink density (SID) variation and deviation and dot
gain variation and deviation were assessed to decide the best sheet that is closest
to standard in his research. Vogl (2004) presented tests and evaluation methods
to assess the temporal consistency of a digital printer. In his research, samples
are printed at different times and solid ink density, tone value increase (TVI),
and midtone spread were measured; the capability of the printing process were
assessed by statistical measures of CP (Capability of a Process) index, CpK index,
variation curve of CMYK solid density, and variation curve of 50% CMYKTVI.

Materials and Equipment

In this research, EPSON Stylus Pro 4000 (EP4K) was taken as a proofer example.
It is run by ColorBurst RIP 4.01. Ultrachrome ink and EPSON Premium
Semigloss Photo Paper were used in the experimental phase. IT8.7/3 basic target
file was output to EP4K for testing samples that were used to reflect proofer
characteristics. Spectrolino Spectroscan was used for measurement to collect
data. In addition, GretagMacbeth ProfileMaker 5.0 and CHROMix ColorThink
Pro 3.0 application software were applied in ICC profile creation and analysis.
Three Excel workbooks were used to analyze the data: Spectro-D_Color.xls,
Onsite.xls, and Output Compare.xls.

Experimental phase

In this document, we will first describe the procedures used to test for inkjet
sample stability. This is followed by the procedures for conducting the measuring
instrument repeatability. Finally, the procedures for conducting the color proofer
stability is described.
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Inkjet Sample Stability Study

In this study, a single sample IT8.7/3 basic target was output to the EPSON Stylus
Pro 4000, and then it was measured immediately on the Spectrolino Spectroscan.
One measurement cycle took 12 to 15 minutes. Five consecutive measurement
sets were finished in about an hour on a single sample. The average AE of 182
patches between each measurement and the last measurement was calculated,
and the outcome expressed as a curve.

Measuring Instrument Repeatability Study

A dry 1T8.7/3 basic target sample, printed by the EPSON Stylus Pro 4000, was
selected to be measured on the Spectrolino Spectroscan. It was measured twice
in a single measurement session. The colorimetric data was analyzed to assess
instrument repeatability.

Inkjet Color Proofer Stability Study

In our experiment, EP4K was taken as a proofer device. EP4K has eight color ink
cartridges. We only enable CMYK to make it only a CMYK color proofer. There
are many factors that affect inkjet proofer color stability. To investigate the color
proofer’s long-term stability, we printed many samples over an extended time
period and measured their color values for our assessment, since the output can
act as an integrated result of all factors.

Procedures:
1. Calibrate EP4K and create an environment in ColorBurst RIP. After many
tests, we set its CMYK Bezier Curve as shown in Figure 1 and saved the
environment as TT_RUN26.env (env26). The output samples were all printed
under this environment.

Figurel: Env26 settings

2. Printthe IT8.7/3 basic test target to produce 30 samples over three months
time. All print samples were printed with the same paper and inks and there
was no manual cleaning of the inkjet head.
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3. Measure the samples to obtain spectral data. The measurements were
carried out after 1 hour of printing the sample to guarantee measurement on a
dried sample. To get accurate measurement data, care was taken not to make
the samples dirty or scratched when measuring.

4. Convert spectral data to CIELAB values and Status T densities for all 30
samples using Spectro-D_Color.xls.

5. Extract color data of C, M, Y, K solid, their 50% color, secondary color,
and CMY color (see Table 1). We need those data in further evaluation.

Table 1: The data table of one sample

[ _PatchiD | Dv Dr Dg Db L a* b*
Sample 1_0207 Zero 0.07 0.08 0.07 0.04 93.98 0.24 -4.24
Description: 100%_K 1.92 1.91 1.92 1.90 10.58 0.80 -0.59
50%_K 0.51 0.50 0.53 0.56 61.97 2.09 4.24
Feb.7,2007 | 8C_Neutral 0.61 057 0.56 0.63 56.93 -2.45 373
7% K 0.1 0.1 0.1 0.09 90.51 0.48 -3.03
0.73 1.42 039 0.14 56.63 -36.79 -54.28
0.29 0.42 017 0.07 79.50 -17.67 -24.63
7% C 0.09 0.10 0.07 0.05 92.81 -1.36 -6.04
Time: 0.70 0.32 1.56 0.66 45.84 77.48 -17.19
50%_M 0.33 0.15 0.49 0.22 71.41 39.52 1953
7% M 0.09 0.08 0.10 0.06 9173 464 -5.78
Temp: 100%_Y 0.12 0.09 0.14 1.18 88.66 -7.39 102.97
50%_Y 0.10 0.09 0.10 0.52 91.16 -9.94 54.10
7% Y 007 008 0.07 0.11 93.59 -2.19 532
Humid: 0.86 1.50 0.51 1.23 47.89 -76.19 37.35
0.71 032 1.65 175 44.34 69.92 53.06
1.64 1.58 1.65 071 18.48 37.07 -59.35

6. Import the data to the Onsite.xls tool for further analysis.
7. Calculate averages data based on all 30 samples.

8. Use the averages as references and perform data analysis on proofer
stability.

Result and Findings

Information in this section follows the Experimental Phase with inkjet sample
stability reported first, followed by measuring instrument repeatability, and color
proofer stability.

Result of Inkjet Sample Stability Study

Figure 2 is the average AE between each of the five measurements taken within
about an hour of printing, and the last measurement, plotted against time. We
can see that AE reduces as time changes. The AE between the first measurement
and the last measurement is 0.2, and the AE between the fourth measurement
and the last measurement is near 0.1, which is such a small color difference that
it makes us consider the ink has already dried at that time. It is not advisable to
measure color data right after printing the sample; it is necessary to wait for the
ink to dry. Therefore, when making measurements only after an hour of printing,
it can be assumed that the influence of ink dry down does not affect the study on
stability of inkjet color proofer.
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Figure 2: The average AE shift curve

Result of Measuring Instrument Repeatability Study

Color repeatability of the measuring instrument includes the instrument itself,
positioning mechanism, and the uniformity of the sample. By comparing AE of
each color pairs in IT8.7/3 basic, we found that the average AE is 0.09 and the
maximum AE is 0.33. A CRF curve of two measurement sets is shown in Figure 3. It
indicates that AE of 50% of the colors is less than 0.07, and AE of 90% of the colors
is less 0.20. We also can find that color variation of the Spectrolino Spectroscan
with EP4K is one-half of the color variation of the Spectrolino Spectroscan with
Epson Stylus Pro 5000 in Chung and Shimamura’s study (2001). Therefore, we
can say the Spectrolino Spectroscan in our study has high repeatability.

===== CRF - 2 Sheets (182 Patches)
—<— Reference

% Cumulative Relative Frequency

2 3 4
AE

Figure 3: CRF of AE between two measurements
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Results of Inkjet Color Proofer Stability Study

1.Density-based Analysis on Stability of Proofer in Terms of Standard
Deviation and Time Chart

Figure 4 is a control chart of CMYK solid density values of 30 samples. The X-axis
stands for samples taken over the period of 30 days, Y-axis stands for density
difference between primary inks solid and reference density. Here average
density of 30 samples is taken as reference density; tolerance of solid ink density
(+/- 0.10) is used per GRACoL printing specifications. We can see that the CMYK
density shifts are in tolerance, only the solid density of magenta is not stable.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30
Sample #

Figure 4: Variation of CMYK solid density

Figure 5 shows the variation of 50% CMYK TVI of 30 samples. Y-axis
stands for TVI difference between samples TVI and reference. Average TVI is
taken as a reference; tolerance of TVI (+/- 3%) is also used per GRACoL printing
specifications. In the chart, we can see that there are big drifts in the first two
samples; the variation of 50% Yellow and Cyan TVI is larger than the rest. If the
large drift was the result of special causes, they were unknown.
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Figure 5: Variation of 50% CMYK TVI

2. Density-based Analysis on Stability of Proofer in Terms of Process
Capability, CP
CP means the capability of a process to stay within specification limits. CP is the

ratio of the variance of the process in relation to the tolerance specified for the
process. The computing formula of CP is :

CP= Tolerance
65
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Here s stands for Standard Deviation. Tolerance is specified, usually from
a standard. The meaning of tolerance and standard deviation is shown in Figure
6. In this project, we specify tolerance according to GRACoL specification. A CP
of more than 1 indicates a process is capable. For this project, if CP is more than
1, it means EP4K is capable.

- Specified Tolerance -
- Random Variation >
1 1 [ 1 1
-4 -3 -2 -1 0 1 2 3 4

Standard Deviation

Figure 6: The meaning of tolerance, standard deviation

Table 2 is the CP value of CMYK solid density. In the table, CP of cyan,
yellow, and black solid density is more than 1, indicating that their process
variability is less than the tolerance. But the variability of solid density of magenta
ink as shown in Figure 4, indicates that there was a shift in process average at
Samples 11 and 12. Although the cause is not known, there must have been an
assignable cause; the data seems to represent 2 populations, each one having
a small variability. This explains why no data point for magenta in Figure 4 is
outside the tolerance, and still CP is less than one.

Table 2: CP of CMYK solid density

SID Dv(k)  [TOR(C) T NNGEMIN oo(v) |
CP 1.46 1.15 0.85 1.32
comment good good not good good

Table 3 is the CP value of 50% CMYK TVI. We can see that CP of 50%
Cyan and 50% Yellow TVI are less than 1, indicating those two are not stable.

Table 3: CP of 50% CMYK TVI
TVI_(50%) K [ c TNV v |

CP 1.59 0.76 1.41 0.54
comment good bad good worst

3. Colorimetric-Based Analysis on Stability of Proofer

Because neutral color is more sensitive to color change, a near neutral color (60C
45M 45Y) is selected to assess EP4K stability. We calculated the chroma value
of this color and observe the AC* deviation to analyze proofer stability. This is
another way to assess proofer stability in term of colorimetry.

Figure 7 is the chart of AC distribution of this gray color compared to
reference (average C*). We can see that this color is not very close to gray, and
the Sample 2 and Sample 12 have noticeable fluctuations. We also can find AC*
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of a few samples exceeds 2, indicating the color is not neutral. The distribution of
sample positions in a*b* plane is not around the aim point according to the plot
in Figure 8. That means this color is not stable in this period.
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Figure 7: Variation of AC
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Figure 8: The distribution of neutral color positions in a*b* plane

Discussion

Figure 5 and Figure 7 indicate there are significant deviations in the first two
samples. If we exclude the two samples for analysis, process capability isimproved.
The results are shown in Table 4 and Table 5. We can find CP of magenta density
is near 1 and CP of cyan mid-tone TVI is more than 1, only CP of yellow mid-tone
TVI magenta solid is less than 1. That indicates EP4K is nearly stable in the time
that produced 28 samples.

Table 4: CP of CMYK solid density

sib Dy [ Dr(C) NG o) |

CP (30 sam) 1.63 117 0.91 1.36
CP (28 sam) 1.46 1.15 0.85 1.32
32 Stability of Ink Jet Color Proofer

Table 5: CP of 50% CMYK TVI

TVI (50%) K [T v
CP (30 sam) 1.59 0.76 1.41 0.54
CP (28 sam) 2.42 1.01 1.81 0.74

Further Research — Explore the impact of proofer consistency

on color proofing
We know that color shifts existed for EP4K from the above analyses. How will
these numerical shifts influence visual color appearance? This is what we should

be concerned about. To clarify this question, a test has been done in our research
with the following procedures.

1. Choose the biggest shift samples (the second sample) of 1T8.7/3 basic to
create an ICC profile.

2. Use average data of 30 samples of IT8.7/3 basic to create an ICC profile.
3. Assign two ICC profile to a legacy IT8.7/3 basic image.
4. In ColorThink, read LAB data of two images.

5. Input these two sets of LAB data into OutputCompare.xls to compare
color difference between them.

6. Draw CRF Curve of color difference in OutputCompare.xls.

Figure 9 is the CRF curve. We can find that more than 90% AE of IT8.7/3
basic are less than 3. If two ICC profiles apply to an image, it is hard to observe
color difference. Therefore, we can say that the color shift of EP4K will not affect
its color proofing heavily.
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Figure 9: CRF curve
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Conclusions

In this research, we studied proofer stability by sampling, measurement, and data
analyses. Densitometric data and colorimetric data were used in our analyses.
Since an output sample includes an integrated result of all inherent variation, we
assessed the samples of a proofer in our study. By applying inkjet sample stability
study, we knew that measurement can get stable color data after an hour after the
sample was printed. By applying measuring instrument repeatability study, we
found the variation of measuring instrument was very small. The following are
our main findings in this research:

1. Using GRACoL tolerances as a guideline, the stability of the color proofer
studied is considered acceptable with the exception of magenta solid ink
density and yellow TVI. However, we would have hoped that a proofer is
more stable than a press.

2. There is no noticeable color image difference between the sample with
the largest deviation and its average according to AE CRF curve.

3. Currently, the industry knows how to certify a color proofer based on
one-time evaluation of a single proof. This research demonstrates how one
would certify routine performance of a color proofer.
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Abstract

Color repeatability addresses conformance to standards and process control to
ensure color consistency in process color printing. While repeatable color is a
virtue, poor color agreement often exists among color printing devices. In this
research, a number of image adjustment methods, from applying transfer curves to
applying device link profiles, were examined to see if one method would achieve
significantly better color agreement than any other methods. We found out that
there is no single method that produces significantly better visual agreement
when the color differences between the two printing systems are small. On the
other hand, the device link achieves the best color agreement when the colorants
of the two color printing devices are different.

Introduction

When sending the same CMYK file to different output devices, the hard copies
often appear differently in color. This is because CMYK is device dependent. When
print buyers demand color matching between different printing devices, they will
not accept the above as an excuse. Thus, printers need a solution to reconcile the
color difference between different color output devices. For repeatable printing
devices, the reconciliation can be done by means of device calibration and color
image adjustment.

Three Levels of Color Match

Before we delve into color matching solutions, let’s take a look at the three
levels of color matching expectations: spectral match, colorimetric match, and
appearance match. Spectral match, being the most stringent of the three, relies
on ink formulation and colorant mixing. The match does not depend on light
source and is regularly applied to ink mixing and spot color printing. Colorimetric
match relies on the principle of tristimulus integration, i.e., by integrating spectral
energy of the light source, the spectral reflectance of the colorant, and the color
matching functions of the human eye. The match may exist between dissimilar
colorants.

* Presented at the 34th International Research Conference of iarigai, Advances in Printing and
Media Technology, September 9-12, 2007, Grenoble, France: Printed with permission.
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Colorimetric match is applicable to proof and press sheet match.
Appearance match, being the least stringent of the three, relies on visual judgment
of human observers that can be influenced by the viewing conditions and the
color vision of the observers themselves. Appearance match is applicable to
pictorial color image agreement, e.g., between proof and print, and is frequently
exercised by graphic designers and print buyers.

Objectives

Given that color differences exist between CMYK devices and that color
differences can be reconciled using image adjustment methods, this research
raises a basic questions, i.e., “Does a particular adjustment method yield better
color agreement than the rest of the methods, and why?” In this research, color
agreement of different image adjustments is determined by visual examination in
the form of paired comparison.

Experimental

This section first describes a situation whereby two printing devices belong to
two different color reproduction workflows. The output of the first workflow is
the press sheet that serves as the reference. The output of the second workflow
is the proof that serves as the sample. Sample proofs need to match the press
sheet closely by means of different image adjustment methods. This section then
describes input materials and equipment used in the experiment. This is followed
by various color image adjustment procedures.

Two Color Reproduction Workflows

To explore various options in achieving color agreement between two dissimilar
color-printing devices, we consider the following two workflows: publishing and
proofing. As shown in the top row of Figure 1, the publishing workflow involves the
conversion of RGB images to the press CMYK space plus printing these images under
calibrated press conditions. The press sheet (CMYK|) represents the reference.

Design Premedia Pagination Print Engine Print
CMYK1 CMYK1 Ink on Paper CMYK1

|

Pagination Pagination Proofing Engine Proof
CMYK1 CMYK2 Colorant on CMYK2
substrate

Figure 1: Two workflows involving two color printing devices

The color proofing workflow (bottom row of Figure 1) starts with the
press CMYK as the input data. The adjustment of color image data from the press
color space (CMYK)) to the proofer color space (CMYK)) is the objective of the
study. Adjusted image data are then printed by the proofer under its calibrated
conditions.
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Materials and Equipment Used

The Heidelberg Speedmaster 74 sheet-fed offset press is the output device in the
publishing workflow. The Kodak NexPress 2100 digital press is the output device
in the proofing workflow. Figure 2 depicts the test form used in the initial phase
of the experiment. Here, color control bars are used for press calibration and
printing process control; 1T8.7/3 (basic) color patches are used to analyze color
differences between the two color printing devices and are used to reconcile
the differences; and pictorial images are used for visual assessment of color
agreement between proof and press sheet.

Figure 2: Test form for visual and quantitative analyses

Four Image Adjustment Methods

The first adjustment method is gradation adjustment. A transfer curve is derived
between the reference gradation and the sample gradation. As shown in Figure
3-left, the procedure begins from (1) identifying an input value, e.g., 80% digital
dot, and trace through the reference gradation to find out the magnitude of the
output (1.0 density); and (2) finding the specific digital dot that produces the
same magnitude in the sample device (85%). If we find enough data points,
e.g., 80% vs. 85%, using the procedure and construct the transfer curve (Figure
3-right), we can reconcile the gradation difference channel by channel.

22

2.0
1.8 Gradation - Magenta

1.6 - - - SM_74_Magenta
1.4 —— NXP_Init_Magenta .
1.2 7

Density

10 domo L Z
0.8 .
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0.4
0.2
0.0
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% Digital dot area

Figure 3: Using gradations (left) to derive a transfer curve (right)
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Instead of using density as the gradation, transfer curves may be derived
using metric chroma (C*) for chromatic inks and darkness (100 - L*) for black
printer. Transfer curves are typically applied at the RIP stage prior to output. In
this research, transfer curves are applied at the image editing stage (early device-
binding) so that sample prints, prepared by different adjustments, can be printed
in a single press run.

The second adjustment method is based on tone reproduction and gray
balance (TrGb for short). This is accomplished by deriving three (CMY) transfer
curves (Figure 4) that satisfy gray balance and, when added the adjusted black
gradation by the first method, also satisfy the tone reproduction between the
reference and the sample.

Table 1: Equivalent neutral dot areas of two printing devices

DK SM74 NexPress
(100 - L*)| %DA C1  %DA M1 9%DA Y1 | %DA C2  %DA M2  %DA Y2

75 89.6 80.6 87.4 96.6 97.7 81.7
65 78.2 65.2 69.6 78.3 76.1 70.4
55 63 50.4 52.7 63.1 60.2 56.7
45 48.3 39.1 41.7 48.7 45.7 44.8
35 35 26.5 30.3 35.4 31 32.1
25 21.6 15.5 19.7 22.2 19.9 20.9
15 8.7 5.5 9.4 10.1 8.9 10.1
5 1.1 0.2 3.5 1.2 0.6 2.8
0 1.2 0.2 3.7 1 0.4 2.7

The fourth adjustment method converts color image data from the press

% Dot Area

100
90
80
70
60
50
40
30
20
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o ¥
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Figure 4: Using gray balance and tone reproduction to derive a transfer curve

To implement the TrGb method, we need to know the combination of
CMY that would render a series of neutrals (also known as equivalent neutral dot
area) for both the reference and the sample device. One way to obtain equivalent
neutral dot area is to construct ICC profiles without the black channel; then use
a color management API, such as ColorThink 3.0 Pro, to find out the equivalent
neutral dot areas for both the reference and the sample device.

As shown in Table 1, the same neutrals are rendered by different CMY
amounts between the offset reference and the NexPress. Here, the neutral is
represented by Darkness (DK), i.e., (100 — L*). So, Figure 4 is the result of plotting
the equivalent dot area of the reference (x-axis) against the equivalent dot area of
the sample (y-axis) for each of the cyan, magenta, and yellow channel. As in the
gradation adjustment method, these transfer curves may be applied at the image
editing stage (early device-binding) or at the RIP (late device-binding) stage prior
to output.

The third adjustment (A-B-A for short) method converts color image
data from the press CMYK (A) space, via the profile connection (B) space, to the
proofer (A) color space. We use the Adobe Photoshop as the color management
API to specify the two ICC profiles and the absolute colorimetric rendering intent.
Depending on workflow considerations, other API, e.g., PDF and RIP, may also
be used prior to output.
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CMYK space directly to the proofer space using a device link profile and the
absolute colorimetric rendering intent. We use Alwan LinkProfiler to construct
the device link profile by concatenating the source (offset press) profile and the
destination (NexPress) profile together while preserving purity of all single ramps
and two-color print solids. We use the Adobe Photoshop plug-in by Alwan to
perform the device link conversion. Color conversion can also be applied to PDF
files using Acrobat plug-in from Callas.

Results and Discussions

Results of the experiment are organized in the following three sections: (1)
verification of adjustment methods, (2) color agreement testing by paired
comparison, and (3) further color agreement testing using different colorants.
Subsequent discussions are also included to reflect key findings in the research.

Verification of Adjustment Methods

Let's begin with the before-and-after comparison of to gradation adjustment
method. Figure 5 shows the adjusted NexPress print (dotted line) and the initial
print (solid line). The left-hand side of Figure 5 is the overall gradation, expressed
as % digital dot area vs. density; and the right-hand side of Figure 5 shows
the density differences relative to the offset reference (x-axis). There are two
observations: (1) the gradation difference is quite small to begin with (something
that we did not envision beforehand), and (2) the experimental error is very small,
i.e., we implemented the gradation adjustment well.
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Figure 5: Verification of density-based gradation adjustment
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The verification of the TrGb based adjustment is illustrated in Figure 6.
Notice that the tone reproduction (solid line) between the initial print and the
offset reference, as shown in Figure 6 (left), do not have a one-to-one relation.
The adjusted tone reproduction becomes a straight-line at 45 degrees (dotted
line).

100

L*C* Neutral

90

80

70

60

50

Sample darkness

40

30

—o—  NXP (Init)
— — NXP _TrGB adjust 20
45-deg straight line

20

—2Zx— NXP (Init)
% — o — NXP _TrGB adjust

0 10 20 30 40 50 60 70 80 90 100 0 2 4 6 8 10 12 14 16
Reference darkness c*

Figure 6: Verification of tone reproduction (left) and gray balance (right) based
adjustment

Figure 6 (right) is the L*C* plot of chromatic neutrals indicating neutrality
difference between the NexPress and the offset reference. Here, the NexPress,
when printed with equivalent dot areas of the offset reference, has fair amount of
colorcast (solid line). The result of the TrGb adjustment restores neutrality (dotted
line) rather well.

Incidentally, the GRACoL Committee in the U.S. developed a Computer-
to-Plate calibration technique, known as the G7 method (IDEAlliance, 2006). It
requires the use of a specially designed gray balance target along with special-
purpose software to derive the transfer curves relative to a few pre-defined
reference conditions. The TrGb adjustment method, described in the paper, offers
a generalized solution for any user-defined reference conditions.

The effect of the A-B-A method can be verified from color gamut of the
initial state (solid line) and the adjusted state (dotted line) of the NexPress in
comparison to the offset reference. As shown in Figure 7, (1) the color gamut of
the NexPress is slightly larger than that of the offset reference; and (2) all corner
points of the adjusted color gamut (dotted line), particularly the yellow solid and
CMYRGB ramps, are closely aligned to that of the offset reference (gray line).

A potential drawback of the A-B-A method is that primary colorants, e.g.,
cyan only pixels, are mapped to pixels with multi-colorants. Consequently, a
small amount of magenta or yellow is also printed where the cyan is by the
destination device. This effect becomes pronounced when single back type
becomes rich (CMYK) black that challenges the registration ability of the press
and causes quality issues in clarity and readability of small types.

The effect of the device link adjustment method is evidenced in Figure
8. Notice how corners of the adjusted color gamut stay unchanged due to the
constraints imposed when constructing the device link profile.
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Figure 7: Verification of A-B-A adjustment Figure 8: Verification of the device link
adjustment

By preserving the purity of single solids and ramps, it overcomes the
printability issues as discussed in the A-B-A method.

One may wonder what is the downside of using device link profile,
particularly in the context of colorimetric accuracy. Our experiences have been
none.This is because pixels in real life pictorial images do not have pixels with pure
primary chromatic colors. Even though the device link profile trades colorimetric
accuracy of the primary colorants for printability, colorimetric accuracy of
pictorial images between the reference and the sample is preserved.

Color Agreement Testing by Paired Comparison

We conducted a paired comparison test using two pictorial subject matters,
Old Man and Gears as shown in Figure 2. Each subject matter is prepared by
five adjustment conditions: (A) initial or no adjustment, (B) gradation, (C) tone
reproduction and gray balance, (D) color management, and (E) device link. Ten
observers were asked to pick one from a pair of prints, under standard viewing
conditions, which matches closer to the offset reference. The test was conducted
one judge at a time (Figure 9).

Figure 9: A judge compares a pair of prints to a reference
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By means of non-parametric statistical analysis (Rickmers, 1973), Table 2
shows that six out of ten judges are consistent in judging a given subject matter.
Only four judges who are consistent in judging both subject matters. Due to
similarity of the color gamut of the two devices, there is no real difference in
the print samples. In fact, the initial print (A) was not ranked the last in both
cases; and the longer one stares at the images, the less certain is about the visual
difference between them. The only exception that a print has real difference is the
Old Man print adjusted by the TrGb method. The TrGb method was ranked as the
best match to the offset reference.

Table 2: Summary of color agreement by paired comparison

# of Ra.nkmg of Significant Correlation | Print that
. adjustment agreement . .
Scene | consistent h P . coefficient | has real
judges methods from | among judges ® difference
J best to worst | at 0.05 risk
Old man 6 CBDAE Yes 0.5 C
Gears 6 BAECD No 0.1 None

It became clear that color agreement between printing devices with
similar colorants is lesser of an issue than color agreement between devices
with different colorants. The reason is because there is not much color difference
existed between the two devices to begin with. In addition, the magnitude of
the process drift and run-to-run variability can easily reduce the effect of the
adjustment.

Further Color Agreement Testing using Different Colorant Conditions

We conducted the experiment using different colorants between the reference
and the sample device in order to further test the effect of image adjustment
methods. In this case, we used the Heidelberg Speedmaster 74 sheetfed offset
press as the reference device and the Epson 4000 inkjet printer as the sample
device. Figure 10 illustrates the test from with the pictorial color images used to
the color agreement assessment.

Figure 10: Test form for visual and quantitative analyses—Round Two
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The ColorBurst 4.1 RIP controls the Epson 4000 inkjet printer by enabling
all CMYK primary inks and disabling all light inks. Figure 11 illustrates the color
gamut difference between the offset press and the Epson 4000 inkjet printer.
Figure 11 suggests that the inkjet color gamut is significantly larger. In addition,
the two magenta inks are very different with the printing ink being more reddish
and the inkjet ink more bluish. In term, there are sufficient color differences in
two-color overprints (red and green).

a*b* Plot

40 60 0 100

-804 SM74
pe | —— EP4K_Init

100

Figure 11: Color gamut comparison between offset press and the Epson 4000

Color Agreement Testing by Paired Comparison— Round Two

We conducted a paired comparison test using five pictorial subject matters
prepared in five adjustment conditions: (A) density, (B) chroma and darkness,
(C) tone reproduction and gray balance, (D) color management, and (E) device
link. Ten observers were asked to pick one from a pair of prints, under standard
viewing conditions, which matches closer to the offset reference. By means of
non-parametric statistical analysis, the results are summarized in Table 3.

Table 3: Summary of color agreement by paired comparison

Number Ranking of | Significant
of adjustment | agreement | Correlation | Print that
Scene . methods among coefficient | has real
consistent . .
Ldees from best judges at (R) difference
Juds to worst 0.05 risk
Camel 7 EDCAB Yes 0.8 Eand B
Pink 8 EDCAB Yes 0.7 E and B
Peony
Red 6 EDCAB Yes 0.9 Eand B
Peony
Lotus 9 EDACB Yes 0.8 E only
Pumpkin 7 DEACB Yes 0.6 B only
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To elaborate, six or more judges are consistent in judging a given subject
matter. There is good agreement among these consistent judges. Due to large
color differences between the two devices, there is real difference in the print
samples prepared by the device link method (E) that produces the best match to
the reference press sheet. The color-managed (D) print came as a close second.
The print sample by tone reproduction and gray balance (C) falls in the middle of
the color agreement ranking. The print sample prepared by the chroma adjustment
method (B) produces the worst match to the reference press sheet.

Conclusions and Further Research

This research explored various image adjustment options in achieving
color agreement between different color printing devices. When colorants are
similar, the color difference between the reference and the initial sample print
is small; no one color image adjustment method yields better color agreement
than other methods. When the color difference between the reference and
the initial print sample is large, the print sample adjusted by the device link
method produces the best match to the reference. This is followed by the color
management method.

To achieve color agreement between similar colorant conditions, e.g.,
from press run to press run, transfer curves derived from either the gradation
adjustment or the tone reproduction and gray balance work well. To achieve
color agreement between different colorant conditions, e.g., proof and print,
device link method performs the best.

Several follow-up research projects are under way. We want to find out
to what extent we can improve the color agreement further by means of profile
editing. We want to predict visual assessment outcome by quantitative analysis
with the use of a synthetic test image that is image content-based, as oppose
to colorant-based, e.g., IT8.7/3 (basic) target. In addition, we want to explore
the above research objectives by means of simulation, i.e., using soft proofing
to replace hard copy, in order to eliminate process drifts and run-to-run color
variations.
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Abstract

This report explains the notion of local image contrast, why it may be desirable to
increase it, and shows how it can be implemented in Adobe Photoshop.

Statement of the problem

Contrast can be defined as the brightness ratio of two areas of an image. A natural
outside scene on a sunny day can have an overall contrast of one to a million.
A photographic transparency with a density range of 3.0 has a contrast of about
one to a thousand, an offset print on coated paper with a density range of 2.0
has a contrast of one to one hundred, and an image printed on newsprint has
a mere contrast of one to ten. This means that a reproduction, particularly on a
low contrast system like newsprint or uncoated paper is relatively “flat” when
compared to the original. We could favor, say the highlights, but only at the cost
of even lower contrast in the shadows. So, the question is: is there a way that we
could make a reproduction with perceptually higher contrast, in spite of the low
overall contrast printing system we have to use?

How do painters do it?

Painters have an advantage over a camera: they look at the highlights and paint
the contrast that they see. Then they look at the midtones and shadows and also
paint the contrast that they see in those image areas. This way they can maintain
local contrast even if the global contrast of their canvas is limited. Could we do
something like this when printing?

What is local contrast?

Here is an example of a local effect on contrast:

Looking at Figure 1, it seems that the left side of a given step is darker
than its right side. The steps are actually uniform, the apparent non-uniformity
is strictly perceptual in our visual system. Figure 2 shows that this effect can be
magnified by placing gradients along the step wedge. And Figure 3 shows that
this effect is negated when the gradients are reversed.

Figure 1: Step wedge
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Figure 2: Step wedge with gradients in same direction

Figure 3: Step wedge with gradients in opposite direction

These effects take place in the eye-brain because of local influences. They
help us see edges and therefore shapes. In case you do not believe that the steps
are truly even, take two pieces of paper and mask off a single step.

There are other famous examples: Adelson’s Checker-Shadow Illusion
shown at http://infohost.nmt.edu/~armiller/illusion/checkerboard.htm and also
at the web page of Arthur Shapiro at http://www.shapirolab.net/ Also on this
page, at the upper left item in the Contrast Isolation menu, Shapiro shows a
remarkable example how, perceptually, contrast is more important than absolute
lightness.

Measurement vs. perception

What is seen is not what is measured. Measurement is not affected by surround
while perception is. Perception relates to relative, not absolute relationships.
Perception has to do with contrast (tonal and color), with differences between
various areas in the visual field, and these differences also include time differences.
The eye-brain wants to see contrast and emphasizes edges because they contain
information; uniform areas contain less information. Perception also has to do
with memory. We know how “memory colors” such as sky, skin, grass should
look like. Perception is a very complex phenomenon.

Measurement is important but, in the end, image quality must be judged
by looking, not by measurement. Optimizing reproduction can only be done
well by someone with an understanding of perception.

Increasing local contrast by using unsharp masking

It is possible to increase local contrast by using unsharp masking. Traditionally,
unsharp masking is used to increase sharpness. Sharpness has to do with edge
contrast, which is one aspect of nearby locality. By enlarging the range of
unsharpness, we can increase local contrast instead of just sharpness. The degree
and quality of unsharpness defines what is “local”.

Figures 4a and 4b explains how unsharp masking can be used to increase
local contrast. They illustrates what is meant by local and global contrast, and
show how the mask does reduce global contrast (because it is negative), while
at the same time, it does not reduce local contrast (because it is unsharp).

46 Increasing Local Image Contrast

Original image Negative, unsharp Mask  Original + Mask Apply Levels or Curves
Local contrast is lost Mask has 50% contrast to restore global contrast.
of original Increases local contrast

-

Shadow
detail

Local
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Darkness

Global contrast reduced
due to negative mask
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.
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Figure 4a: Using unsharp masking to increase local contrast

Original 65% Unsharp Mask  Original + Mask Restored
Global Contrast

Figure 4b: Using strong unsharp masking to increase local contrast for an image

Methodology of increasing local contrast in Adobe Photoshop

1. Itis desirable to use as large an image as possible, and downsize the image
after local contrast was increased. Make a duplicate of the image: Image >
Duplicate... Edit the name by replacing “ copy” with “_LC".

2. Increasing local contrast has to do with tone reproduction, not with color
reproduction. Therefore, the duplicated image is first converted to Lab Color
space: Image: > Mode > Lab Color and only the L* channel is activated:
Window > Channels > Lightness. (At the end, the file can be converted back
to the original color space.)

3. Tomake the unsharp mask: Window > Channels, (make sure only the Lightness
channel is selected), click on the button with the arrow on the tab of the
Channels window, a pull down menu opens, select Duplicate Channel... and
name it Mask.

Now this mask has to be made unsharp: Filter > Blur > Smart Blur...
The big advantage of the Smart Blur tool is that, by setting the threshold, high
contrast edges are not blurred which avoids “haloes” around edges. For each
pixel, the Radius sets the distance which is searched for dissimilar pixels
(spatial aspect of “local”). The threshold sets how dissimilar the pixels have to
be in order not to be blurred (tone value aspect of “local”). The selected area
is then blurred. Choose Quality: High and Normal mode, and set Radius to 5
and Threshold to 40. These two settings define what is meant by “local”. All
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texture should be lost in areas where contrast finally should be increased, but
not more than that. Figure 5 shows various amounts of smart blur.

Sharp R40/T10 R40/T40 R5/T80
Figure 5: Various degrees of blur, settings for: Radius / Threshold

4. Next the mask is made negative and added to the original Lightness channel.
Go to: Image > Calculations... (see Figure 6.)

Figure 6: Image calculation settings

Source 1 should be the mask, and it should be inverted (made negative).
Source 2 is the Lightness channel, not inverted. Blending mode should be
Add. The setting you may want to change in this dialog is Opacity: It sets
the percentage of the contrast of the mask relative to the original. The higher
the setting, the stronger will be the increase in local contrast. More than 60
may be too much, try 50 to start. After clicking OK, a new channel Alpha 1 is
created which will become the new, enhanced Lightness channel.

5. Restoring channels: Window > Channels. The original Lightness channel and
the mask channel are deleted by dragging them to the trash can symbol at the
lower right of the Channels window. When the Lightness channel is deleted,
the image mode is changed to Multichannel, and all channels become Alpha
channels. To convert the image back to Lab mode, Alpha1 channel is dragged
up and dropped as the topmost channel which is the position for the Lightness
channel. Then, color mode is changed to: Image > Mode > Lab Color

6. Restoring global contrast: Image > Adjustments > Levels ... Adjust the three
pointers until the image regains the full contrast. The chosen settings have
a large influence on final image quality. Set the dark pointer to almost the
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thin end of the shadow tail. This shadow tail contains the information for
the darkest shadows and will be necessary if it is important to open up the
shadows. The middle pointer (gray) is used to set the midtone darkness. This
is where the decision is made where most of the detail should be, dark areas
or light areas. The white pointer sets the white point of the image. Using an
S-shaped curve on the lightness channel can be very effective in balancing
highlights, midtones and shadows.

That's it, color mode can be changed back to what it originally was.

8. Sharpening could additionally be applied to further enhance the picture.
Sharpening enhances the local contrast of edges. Other adjustments like
curves, saturation, noise reduction, size may be necessary at this time.

Figures 7 and 8 on the following page demonstrate a result with strong local
contrast enhancement. Sharpening was applied.

Application of local contrast enhancement

Local contrast enhancement can be used on “good” and “bad” images. The effect
is most noticeable on images with larger areas of low contrast detail (large image).
On images with lots of fine detail the effect is less visible (small images).

When an image is over- or underexposed, not all tone levels would profit
from increasing local contrast. An overexposed image has flat highlights, and an
underexposed image has flat shadows. However, the method shown enhances
local contrast equally for all tone values. Therefore correcting poorly exposed
images requires other tools before local contrast should be enhanced.

Changing tone reproduction may affect the saturation of colors. When
applying curves on the final RGB image, saturation changes a lot. When applying
curves to the Lightness channel of the Lab image, saturation is not affected.

Increasing local contrast for printing is particularly useful for low contrast
printing systems such as newsprint. A Photoshop-based methodology was shown,
but Photoshop has many other tools that affect contrast. Very effective in opening
up shadows is the tool Image > Adjustments > Shadow/Highlight... .

The contrast that is seen on the monitor, or on a proof, or on a press sheet
may be different. Large images need different settings than small images. An
image with increased local contrast may look grainy when viewed at 100%. But
at the actually used size, it is OK.

Acknowledgements
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have profited greatly from his knowledge and expertise.

Note

Additional information and a free download of an Adobe Photoshop Action for
enhancing local contrast are at http://www.rit.edu/~gravure/CMS2007 /tools.html

Increasing Local Image Contrast 49

Test Targets 7.0



Test Targets 7.0

50

Figure 7: Original image (Courtesy: Lisbeth Scherrer)

Figure 8: Local contrast, Blur 5-40, Opacity 75 + sharpen + curves

Increasing Local Image Contrast

Densitometric Gray Balance & Neutrality
Determination

Steve Suffoletto
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Abstract

This paper investigates the relationship between measurements of gray balance
by densitometry and colorimetry. The research question is “Can three-filter CMY
density spread be a useful predictor of gray balance?” If the correlation between
Status T three-filter CMY density spread and CIE C* is strong enough, then density
spread can be used to determine gray balance. It was found that absolute density
is approximate but sufficient for determining gray. Better results are obtained when
a known gray target is used as a reference and then the relative three-filter CMY
density spread is measured. This technique can be used to find, monitor, and control
gray balance if a colorimeter is either not available or its use is not understood.

Introduction

Gray balance is an important color reproduction parameter because it has a global
effect on all colors in an image or on a press sheet. Any bias or drift away from
gray balance also produces the same bias in all the other colors. This can cause
adjacent colors on the color wheel or circle to change hue. For example, adding
some yellow bias to magenta makes it appear redder. Likewise, complementary
colors diagonally across from each other will become less saturated or grayer. A
common term for this is dirty or muddy. For example, adding some yellow bias to
blue (not cyan) makes it appear less saturated or grayer, not greener. See Figure 1.

-+ —

— —

Figure 1: Magenta plus Yellow results in a hue shift toward Red. Blue plus Yellow results
in a chroma loss adding Grayness.
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Gray balance means grays appear neutral, without any predominant bias
or cast. Photography and videography often call gray balance color balance, i.e.,
reproducing a gray scale in the scene as neutral as possible. In CIE Lab color
space, neutral grays are located at the very center intersection where both a* and
b* are zero (0). In the RGB color space, neutral gray occurs when there are equal
and balanced amounts of red, green and blue light present, whether reflected
from an opaque object, transmitted through a transparent object, or emitted from
a light source. So, if R = G = B, then it is equal and balanced to neutral gray. For
example, entering equal or balanced amounts of RGB into Adobe Photoshop’s
color picker always produces a neutral gray where a* and b* are zero (0). See
Figure 2. RGB gray levels near 0 are black, near 255 are white and near 128 are
middle gray. Thus, only the lightness or L* is changing.

Figure 2: Equal RGB = Gray, but Equal CMY doesn’t equal Gray

In CMYK color space that uses colorants that absorb RGB light, it is
not equal or balanced CMY colorants we desire in order to achieve neutrality
(50%C, 50%M, 50%Y) but rather their densities. But if we make the dot areas
unequal (50%C, 40%M, 40%Y), we then make their densities equal. See Figure
2. The CMY dot areas are colorant input signals which modulate RGB light; the
resulting CMY density is an output response. D= -logR. So what is true in RGB
additive must also be true in CMY subtractive because of their complementary or
opponent relationship.

The reason equal dot areas do not produce a gray is because the pigments
used in the printing inks are not ideally pure and have some normal unwanted
light absorption. Printers call this densitometric hue error and grayness. Since
magenta has about 45% hue error toward yellow and cyan has about 25% hue
error toward magenta, a 3-color gray of equal dot sizes (50%C, 50%M, and
50%Y) is contaminated with an orange, making it look warm brown. But, by
reducing both the magenta and yellow dots from 50% to 40%, we can eliminate
this warm colorcast. We could have also increased the amount of cyan from
50% to 60% but that would have also darkened the tone. In Figure 3, the outer
surrounding background is always a 1/c-K screen tint of 50%. The center insets
have different CMY dot areas.

52 Densitometry Gray Balance and Neutrality Determination

Inset is too warm; Inset is gray but too dark; Inset matches
C50, M50, Y50; C60, M50, Y50; C50, M40, Y40

Figure 3: Examples of different dot area gray balances

The theoretical or scientific definition of neutral, based on colorimetry, is
when C* = 0, which means a* and b* are also zero. However, a more practical
definition of neutral for technology implementation should take into account the
effects of any visual references, such as the white paper (0% dot), the solid black
ink (100% dot), or the 50% black screen tint which is halfway in the middle. At
50% dot, both the white paper and black ink are influencing the appearance.
In the highlights, the paper has a larger influence. Likewise, in the shadows, the
ink has a larger influence. So, any changes to the paper or ink, as well as the
lighting or viewing conditions would change the appearance of neutral gray.
There is a current trend for papers to be made bluer, with a larger -b* value. This
increases their TAPPI brightness. Currently, an ISO type 1 paper (gloss coated) has
Lab values of L* = 95, a* = 0, and b* = -2, when measured on a white backing
material.

Certainly, gray balance is best measured using colorimetry, specifically
with C* from CIE LCh. Whenever possible, gray balance should be measured
using Colorimetry C*. Colorimetry is trichromatic due to the XYZ Tristimulus
values. Tristimulus integration combines the effects of the light source, the object
that modifies the light, and the human eye’s visual response through red, green,
and blue cones. Colorimetry is best because it strongly correlates with human
vision since it uses the CIE Standard Observer (2-degree) and defines the light
source with a standard illuminant (D50).

A densitometer is a trichromatic instrument that consists of three broad
or wide band filters, Red, Green and Blue. In North America, Status T response is
the norm. In normal process control practice, solid ink density (SID) is measured
through the complementary filter to produce the highest density (signal). See
Figure 4.

Ink Color Black Yellow

Filter Calculated
Color Average of RGB

Figure 4: Corresponding filter for ink color

However, by looking at three-filter CMY densities, (X-Rite “ALL" display
mode) we can increase the limited information that only a single filter density
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provides (X-Rite “AUTO” display mode). Obviously, the trichromatic response of
a three-filter densitometer is not the same as a colorimeter’s standard observer.
The technical term is anomalous trichromat.

C* is a more efficient metric than a* and b* because only a single value
needs to be evaluated. Mathematically C* is the longest side of a right triangle,
the hypotenuse. When C* is zero (0) the color is hueless, achromatic, and neutral
gray. To evaluate neutrality in CIE Lab, both a* and b* must be examined and at
zero to be neutral. Graphically, C* is a radius line of a certain length and shows
magnitude but not direction. Hue angle (h’) or a* and b* show direction. The
shorter the length of the C* radius line, the more neutral. The shortest possible
distance is zero, which is at the center intersection. The longer the C* radius line,
the more colorful or saturated the color. Because C* is calculated from both a*
and b*, it makes C* a two-dimensional measurement.

This paper’s audience is focused at smaller-sized printers who may not
have the necessary instrument technology and/or the understanding to properly
practice colorimetry. A colorimeter costs about $4,000, twice the price of a
densitometer at $2,000. A spectrophotometer is almost three times the price
at $6,000. Many printers buy a spectrodensitometer but only use, know, and
understand the simplest of functions, just density. Often, this is also the case
for off-line scanners, not just hand-held instruments. Some printers may have
a sophisticated X-Rite ATS or ITX scanner but only use it to measure density!
So, this study has those printers in mind. Again, the research question is “Can
densitometry be a suitable substitute for measuring gray balance?” With the
recent introduction of GRACol’s “G7™” calibration and control method in 2006,
there is a renewed interest in gray balance making this research topic timely
and relevant. In the print media production workflow, prepress makes a color
separation to establish gray balance then makes a proof to show that gray balance.
Finally the pressroom prints to maintain and preserve the gray balance prepress
established. Gray balance is an important aspect of work based on ISO, FOGRA,
GRACoL and SWOP.

Objectives

Research was conducted to:

1. Determine if a Status T densitometer can be a useful predictor of neutrality to
accurately measure gray balance.
2. Determine appropriate tolerance limits for densitometric gray balance.

Methodology & Experimental

To conduct the experiment, only a measuring device and a printed or proofed
target are necessary. An X-Rite 528 spectrodensitometer was used to provide both
densitometric (CMYK) and colorimetric (Lab) information. Spectral reflectance
data is not required. The test target can be any typical gray balance finder target
available from several sources or could be custom made. See Figure 5.
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Figure 5: The actual gray balance finder target that was measured

The scope for this investigation is limited to just the 50% midtone portion of the
tone reproduction scale and not the one-quarter (25%) or three-quarter (75%)
tones. ISO 12647-2 states that mid-tone gray balance consists of 50%C, 40%M,
40%Y, and 0%K when at the correct solid ink density (SID) and tone value
increase (TVI).

Measurements

All measurements were made to ANSI CGATS.4, CGATS.5, ISO 13655, and ISO
13656. The illuminant is D50, standard observer is 2-degree, 0/45 geometry,
black backer, Status T filter response, dry densities, absolute with paper included,
and non-polarizing.

Each patch was measured twice, once for Status T density then immediately
again for CIE Lab color. Density was measured using All filters option with high
precision so three decimal places was obtained.

Analysis
The measurement data was analyzed in Microsoft Excel and several graphs created.

From Lab, C* was calculated. The formula for C* is simply C*=+a**+b**. For
each patch, three filter CMY density “gray spread” was calculated. Gray Spread
= Max (Dr, Dg, Db) — Min (Dr, Dg, Db). For example, if C = 0.61, M = 0.60 and
Y = 0.59, then the gray spread would be 0.02.

Densitometry Gray Balance and Neutrality Determination 55

Test Targets 7.0



Test Targets 7.0

Results and Discussions

The first step was to determine which patches in the gray balance finder target
were really gray using colorimetry. Of the 49 patches, 10 were identified as being
“gray” using a C* tolerance <=2.0. See Figure 6. An a* and b* tolerance was not
used since it produces a square shaped tolerance limit. Instead, C* produces a
circular or round tolerance limit. Fitting the smaller area circle inside the larger
area square produces four corners that the circle does not include. These corners
represent unwanted false positive signals. At a tighter tolerance of C* <= 1.0, there
were only 5 neutral patches. This was not used because such a tight tolerance is
not practical in manufacturing.
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Figure 6: Identifying which patches are really neutral gray with C* <= 2.0
The next step was to evaluate the three-filter CMY density gray spread.

The lower or smaller the gray spread, the more neutral gray the 3-color CMY
patch should be. See Figure 7. There were 12 patches that had a gray spread of <=
0.02 density. Of these, 9 patches had good density agreement with the C* data.
This is a 75% accuracy rate. A commonly quoted density spread for gray balance
is =< 0.03. At this wider tolerance, now 20 patches are included. Unfortunately,
this wider tolerance produces too many false positives and lowers the accuracy
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Figure 7: Identifying which patches have the lowest density spread

Finally, the correlation between C* and Gray Spread was compared and
found to be good using a second order polynomial. See Figure 8. The correlation
coefficient value (R?) is 79% and considered acceptable for production use. If
only the 10 patches where both C <= 2 and density Gray Spread <= 0.02 are
used, then the correlation improves to 84%.

rate to just 50%.
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Correlation between C* and Three Filter CMY Density Spread
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Conclusions

The following presented in questions-and-answers format summarizes this
investigation.

Can a densitometer accurately measure gray balance? Yes.

For printers who do not have a measuring instrument capable of colorimetry or
have operators who don’t understand colorimetry, density spread is a somewhat
effective (84% accurate) alternative method to C*. This method can easily be done
with any hand-held densitometer that can display all four filters simultaneously.
Having a software feature in the densitometer that automatically calculates the
density spread would be of convenient value.

The advantage to this density method is that printers can use existing,
older densitometers and do not need training on more sophisticated technology.
An off-line scanner would obviously be much faster. X-Rite’s IntelliTrax (ITX)
scanner (software version 1.4.0.30) currently can display gray balance using
CMY three-filter density spread.

What calibration, setup conditions, and procedures are necessary for
this method?

The fundamental issue is densitometry uses Status T filtration and not colorimetry’s
D50 illuminant and 2-degree observer which imitates human color perception.
Therefore, to compensate for this difference and improve accuracy, measurements
are made relative to a known or targeted reference. The reference is stored into
memory and can easily be automatically retrieved after measuring. The target
stored as a reference can be an OK proof or OK press sheet. Usage this way is
an effective process control technique. To find a known neutral gray of C* = 0
to be used as a reference, it must be obtained from previously verified samples
measured with a colorimeter. Possible physical samples that have very low C*
values may be Munsell N8 found on some color viewing booth table top or walls
or Pantone Cool Gray 7.

What are appropriate tolerance limits for densitometric gray balance
spread?

A three-filter CMY density gray spread of 0.02 or less (<=0.02) is an appropriate
tolerance for determining gray balance with a densitometer. However, a significant
portion of this tight tolerance is consumed by instrument repeatability error.
Modern spectrodensitometers now have less instrument repeatability noise or
error. With older instruments, it was +/- 0.01. Today it is better at only +/- 0.005
density, per the manufacture’s technical specifications. So, the density spread
tolerance of 0.02 compared to the instrument repeatability of +/- 0.005, represents
about 25% measurement error. A Gage Repeatability and Reproducibility (GR&R)
study recommends the measurement noise be less than 10% of the total tolerance
range. However, to put this into practical perspective, current video camera plate
readers are only accurate to 0.5% dot area. If the tolerance for CtP is +/- 1%,
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then the noise is also 25%! This amount of error does not seem to be much of a
concern for many users.

Further Research

In the future, additional testing should also be done in the 25% highlights and
75% shadows. Also, the gray balance test target varies the magenta and yellow
for a fixed 50% cyan value. Additional +/- 5% cyan values, from 45-55%, should
also be evaluated. An alternative measurement method would have been to
measure spectral data and use Excel to calculate Status T density and CIE Lab,
LCh.
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The sample wedges on this page show some of the possible
variations. There are different color labels, corner dots,
gradients, and different colors and sizes. Since the content of
this book is printed CMYK only, no spot colors are shown.
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Automated Test Wedge Generator
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Abstract

Step wedges and gradients are basic tools used for production control, testing,
and research. This article describes an automatic test wedge generator that permits
custom designing of these tools.

Introduction

When doing testing, research or production control, special test wedges are
needed, but often we use generic scales because that is all we have and to make
a customized version is not a trivial matter. Often we have specific needs for the
number of steps and the dot areas on these steps; the size of the patches; the
number of colors, overprints and possibly spot colors; and the inclusion of an
additional gradient.

Test Wedge Generator

To facilitate production of these tools for research at RIT, PostScript code was
developed where the necessary modules can be customized by setting parameters
in the header of the EPS file.

This helped a lot, but was still a little cumbersome to use because,
for instance, to calculate the BoundingBox in the EPS file is not that simple.
Therefore, a Microsoft Excel spreadsheet was developed that lets the user define
the aspects of the desired scale and then, with the use of a Visual Basic macro,
the parameters in the EPS file are automatically set, and an indication is given
where the test wedge file is saved.

This EPS file can be used in an Adobe InDesign page as part of a test form
or it can be converted to PDF using Adobe Distiller. And, if necessary, it can even
be fine tuned in Adobe Illustrator. The file is a legacy CMYK file and should not
be color managed.

Note that in Illustrator, spot color patches are shown white. However,
when clicking on a step, the correct color designation is actually there; just the
preview feature does not work right. The same file opened in InDesign shows
the correct preview. Acrobat also does not show the spot colors, but, when using
Advanced > Output Preview, the spot colors are named, and the dot areas are
indicated when the cursor is placed on a given step.

There is a free download of this Test Wedge Generator tool from http://
www.rit.edu/~gravure/CMS2007 /tools.html
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How is a Gradient Made?

A gradient shows very smooth transitions from 0 to 100% tone values. In a digital
system, the smallest difference between two tone values is one bit. This means
that for an 8 bit system, there are 28 or 256 gray levels. Therefore, a gradient
is nothing other than a step wedge, where the steps have one bit tone value
difference between them.

PostScript can be in vector or bitmap mode. Normally, gradients are
programmed as bitmaps. But they could also be many small steps in vector mode.
The code generated by the Test Wedge Generator tool uses vector code for the
step wedges and a bitmap for the gradient. This version of the tool can only make
one gradient. If several gradients of different colors are needed, the following
‘trick” can be used to make multi-color gradients:

Make a 256-step wedge where each step increment is 0.39215686
percent dot area (i.e., 100% divided by 255 increments). If you make the step size
4 mm wide, this makes a step wedge that is more than 40 inches long. That is
OK, because the generated EPS file can be edited in Adobe Illustrator for various
aspects such as rescaling (possibly non-uniform), text addition / removal, etc.
Go to Object > Transform > Scale... in the Non-Uniform scaling option, change
the size to 10% in the horizontal direction and to 100% (or more) in the vertical
direction. Keep the Scale Strokes and Effects option unchecked.

Now the wedge becomes a manageable size, butall labels are unreadable.
To correct this, press command+A on the keyboard to select all the objects;
and restore character width (Horizontal Scale) to 100% in the Type > Character
window. Delete the labels for the step wedge (there are too many), only keep the
ones for the gradient. What you now have is a vector version of the gradients.
Notice that there is no visual difference between the step wedge and gradient in
Figure 1.

Gradients can, of course, also be made in Adobe Photoshop. The
difference is, that the ones generated by the Test Wedge Generator tool are linear
and calibrated; therefore more useful as a test target. When the EPS file is opened
in Photoshop, it will show a flat histogram; while a gradient natively-made in
Photoshop shows a curved histogram.
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Figure 1: Edited version of 256-step wedge and a bitmap gradient

Automated Test Wedge Generator
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Test Targets 7.0

with a pano head in the same manner as Professor Cost did in the morning of a
spring season. Red brick building, red brick pathway, and crab apple trees were
accentuated by the blue sky and green grass nicely. There are also a couple of
interesting effects to look at.

You may see the effect of gloss in this panoramic reproduction on p. 70.
A text-based gloss used with the message “RIT Gannett Building, Home of School
of Print Media” is detectable on the left-hand-side page; line screening without
gloss was used on the right-hand-side page. This is to bring contrast between it
and the folded panel, which is printed in full gloss. In addition, notice the two
lines running on top and bottom of the panoramic image. Are they just one-point
rules? No. Are the two lines identical? No. What are they? They are micro texts,
RIP-based micro fonts available, from NexPress.

Conclusion

Examples of “changing scene” from students in Professor Tommie Nystrom’s class
at Linkoping University in Sweden are enlightening. I’'m beginning to think about
giving a similar assignment to my students at RIT. What kind of image will they
come up with? An advertising promotion for a stretched limo? A stretched laptop
computer with a wider screen?

Executing the ‘unchanging scene’ with folded panel is more of a
technology challenge than design-oriented solution. The use of a panoramic
scene is desirable because of the added width. The page-to-panel match depends
on cutting and folding accuracy. It also depends on color match at the crossover.
Thus, the degree of success depends on planning, testing, and execution. For Test
Targets 7.0, we took aim at pushing the technology to its limits. In the end, we
will find out what worked well, what can be done better if given more time and
resources, and what to avoid at all costs.

In conclusion, folded panels offer plenty of creativity, visual interest, and
lively discussion. Print media mixed with design is fun, isn't it?
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Pages 65 - 72 of the Gallery of Visual Interest were printed on a NexPress
digital press, for it is impractical to produce the folded panels with selective gloss
and watermark effects on a web press.
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Press Run Organizer - Heidelberg SM 74

Press Run Organizer - GOSS Sunday 2000

Project description:
Press date:

Project leader(s):
Telephone No:
Today's date/time:
Prepared by:

Test Targets 7.0 Cover

Printing description: (1) Prepare publication cover using Illustrator CS3 and

Tue., Oct. 30, 2007

Bob Chung, Franz Sigg, & Sri Prakhya

475-6806 (CMS Lab)

distill as PDF/X1a file; (2) prepare CtP using Creo Prinergy; (3) print to
specifications (3 spot colors + black) using Heidelberg SM 74; (4) ship 2,000
for bindery. (1000 sheets - 2 up)

Product description: Cover printed by three spot colors plus black; five 16-page

10/25/07

Bob, Fred White and Barb Giordano

signatures of text printed by Goss Sunday 2000; 8 pages with folded panels,
printed on NexPress; Binding: die score and PUR adhesive; trimmed to final
size 8.25" x 10.5" - total 92 pages; Final quantity: 1,500

Job Specifications

Production Notes / Quality Assurance

Project description:
Press date:

Project leader(s):
Telephone No:

Test Targets 7.0 Body

Printing description: (1) Prepare publication text using InDesign CS2; (2) prepare

Mon., Oct. 29, 2007

Robert Chung, Franz Sigg, & Sri Prakhya

CtP with 175 Ipi AM screening by Creo Prinergy; (3) print to specifications using
Goss Sunday 2000 as indicated; (4) ship 2,000 signatures for bindery.

475-2722

Product description: Cover printed by three spot colors plus black; five 16-page

PREPRESS
Contents:
Color control bar:
PROOF
Manufacturer:

Brand:
Proofing guide:

2-up: Front & back cover + type on
spine
Solids

RIP/PLATE
Manufacturer:
Brand:
Plate exposure guide:

Creo Prinergy 3; 150 Ipi AM
CREO VLF 2400 dpi

KPG(12mil); thermal Gold

Rex28.eps, Kexp34.eps

PRESS
Manufacturer:
Brand:
Size (max):

Heidelberg sheetfed offset press

Heidelberg 6-color SM 74

20'x29' (max)

FOUNTAIN SOL'N

Manufacturer:

Brand:

pH/Conductivity:
BLANKET

Manufacturer:

Brand:

Packing:

Printer Services

Prisco 2451 + Alkaless 3000

pH 4.0 buffered; Conduct. 2100

Day International 3000

Patriot

0.006" over bearer (all units)

INK

Manufacturer:
Brand:
Temp./Tack:

Pantone 7466 C, 1788 C,
361 C (5.0 Lbs each) are supplied, Black
Superior Ink

PAPER

Brand:
Basis weigh / Size:
Quantity:

PRINTING
Ink-down sequence:
*Solid ink density:
(+0.10)

Approximate Lab values:

L*

1788 C 53.29

7466 C 57.58

361 C 59.88
Tolerance AE of 4 or less
**Dot gain:

(-3%/+6%)

NewPage Sterling Ultra

100# gloss cover, 20x26, grain long

3,000 (incl. 2,000 for makeready)

Reference:
3 spot colors + Black + aqueous (overall)

K: n/a

a* b*
71.36 46.24
-52.94 -25.05
-50.68 47.59
(D50 2° observer)
K: n/a

Notes on digital workflow:
Paginated as reader's spead in Illustrator CS3;
PDF/X-1a using Prinergy PPD and JobOptions as single page;
Impose in Preps according to the imposition layout
Make sure 1/8" bleed is included in pagination; spine 7/32"

Note on imposition: (see below)
26" (grain long) A

v

|

10.5"

Front

10.5"

Front

20"

8.25" 8.25"

Notes on server: smb://cias-files.rit.edu/courses; then push to PAL server

Notes on RIP and screening:
RIP: Creo Normalizer JTP; PS Version: 3011.104

Production schedules:

Cover press run by SM74: Wed., Oct. 31, 2007
Body by Goss 2000: Tue., Oct. 30, 2007
GVI by Nexpress: Oct. 22 - 24, 2007
Bindery by Riverside: Thur., Nov. 1, 2007
Finished book delivery: Fri., Nov. 9, 2007
Distribution: Paper donor 200

RIT/PAL 200

RIT/Sloan 200

RIT/SPM 900

SAMPLING &
REPORTING

Per Franz Sigg's input
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Sheet-fed Press Run Organizer

Today's date/time: 10/25/07 signatures of text printed by Goss Sunday 2000; 8 pages with folded panels, printed
on NexPress; Binding: die score and PUR adhesive; trimmed to final size 8.25" x
10.5" - total 92 pages; Final quantity: 1,500
Job Specifications Imposition and Signature Alignment of the Hybrid Digital/Offset Workflow
PREPRESS Print on both sides
Signature contents: Five 16-page signatures TS s & s oages G055 2006 o s s
Image resolution' 300 ppl 4 Sheets @ 4x2 pages Next Press; PDF/X3 workflow
. Front /
Color control bar: RIT Color Control Bar plus 100 % Sommres Signares B Paginaton Righttett ST category
sheet
Take-up bars for CMY; none for Black X : e
3 i R B Front matter  Table of Contents
ICCPROFILE  GRACol ICC profile s R F Frommater Intoandachmowedgment
6 iv L B Front matter  Intro and achnowledgments
PROOF ot ; ; 'E E Ruhenc;mng Colorimetry o
Manufacturer: » : 6
Brand: b : :
Proofing guide: 5 5 " :
. 14 14 L B
- - 15 15 R B
RIP/PLATE Creo Prinergy 3; 175 Ipi AM Lo L - . -
N rving oftproofing
Manufacturer: CREO VLF 2400 dpi 1 b L 8
Brand: KPG(12mil); thermal Gold n o R .
Plate exposure guide: Rex28.eps, Kexp34.eps 5w R 8
Sig. 2 24 24 L F
PRESS 25 25 R F WuHuiliu Inkjet Stability
26 26 L B
Manufacturer: GOSS Web Press z x R 8
Brand: Sunday 2000 % = : 6
Size (max): 22.75" x 57" R p ;
o 33 33 R F
FOUNTAIN SOL'N 3 & Hemee
Manufacturer: Anchor 0® L £
Brand: #20365 Prolmage 3000 HP » » K :
pH/Conductivity: pH 4.0 buffered; Conduct. 2500 - 2600 29 | 5 ;
BLANKET A -
. 44 44 L F
Manufacturer: Day International Sleeve ©o s h £ FaneSgg  Localimage Conrast
Brand: o I ;
1 . 49 49 R F
Packing: 2 o2t ...
INK Process color = = . ;
Manufacturer: Flint Ink u o= L 8
Note: A - R ;
. 58 58 L B
el 2 o2 ¢ ...
61 61 R F
. 62 62 L B
Brand: NewPage Sterling Ultra Web Gloss & e h e SN s o pesin
Basis weigh / Size: gloss 100# text, 35" wide roll e 2; : ey
Quantity: Nespress o o I Gallry
69 69 R Galler
PRINTING Reference: GRACoL -- o ™ L 8:::2%
Ink-down sequence: Black, Cyan, Magenta, and Yellow oo L e e
SID (wet): K: 1.65 M: 1.40 noon 5 6 Tease S
(+0.10) C: 1.30 Y:1.00 CENEE T~ R
Dot gain: K: 24 M: 22 79 9 R B T::P:g: wysmanancwx
(-3%/+3%) C: 22 Y: 20 N R P e
) N 82 82 L B BackMatter  PressRunOrg
Note: B o p P Gaater PessRunorg
85 85 R F BackMatter TestTargets Team
86 86 L B BackMatter TestTargets Team
87 87 R B BackMatter TestTargets Team
88 88 L F BackMatter  Paper Press Info
SI?A;EI\IQEIE{[II'\:EISL Per Franz's Input
Web Press Run Organizer 83 Test Targets 7.0




Press Run Organizer - Kodak NexPress

Project description:
Press date:

Proof date:
Project coordinators:

Test Targets 7.0 GVI NexPress

Tue., Oct. 22 & 25, 2007

Fri., Oct. 19, 2007

Objectives: (1) Content preparation for Test Targets 7.0

(2) Test visual elements on Pages with folded panels

Bob Chung & Franz Sigg

475-2722 (0)

Notes: File location: CMS server

PAPER
Brand:

Basis weight:

Grain direction:

NewPage Sterling Ultra

gloss 100# text 18" x 12"

Grain short

Today's date: 10/25/07
Job Specifications Production Data
TEST FORM Number of pages: 8 Sunday  P1 AM
Descriptions: Each sheet is one page with folded 2000 P2 AM
panel duplex NexPress P3 AM Classic
Image resolution: PAL P4 AM Classic } Sheet 1
P5 AM Classic
PAGE LAYOUT P6 FM } Sheet 2
Software: PDF or InDesign CS3 - NexPress P7 AM Classic
Interchangeable Exchange Document |Kodak P8 AM Line + text gloss } Sheet 1
Dimension: 12" x 18" P9 AM Line
Color control bar: P10 AM Line + full gloss } Sheet 2
« > A
COMMUNICATION Y Y 18"
File Submission Protocol: CD or Flash Drive 8.125" 4"
File Creation Procedure: TT7 PDF SOP < < >
Hard copy Proof: Yes
DFE ; 12"
RIP manufacturer: NexPress NexStation 10.5 10.5"
Brand: Kodak
Screening: AM (Classic/Line) \4 v v
FM
PRESS PAL Kodak
Manufacturer: Kodak Kodak
Brand: NexPress 2100 NexPress
Number of colors: 4 5 + Gloss
Colorant sequence: KYMC KYMC + clear

PRINTING Reference: NXP Calibration
Solid ink density: C: 1.59 M: 1.59
(x0.10) Y: 1.04 K: 1.57
Dot gain: C:21% M: 16%
*3%) Y: 18% K: 17%
SAMPLING 1) Short-term: None

2) Long-term: None
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The Test Targets 7.0 Team

Authors

Robert Chung, Gravure Research Professor

Robert Chung is a professor in the School
of Print Media, Rochester Institute of
Technology. Bob  teaches technical
courses in process control and color
management and has published over fifty
technical papers. Bob was named the RIT
Gravure Research Professor in 2004. He is
the recipient of the 2007 Educator of the
Year Award from the Electronic Document
Systems Foundation (EDSF); the 2007
Fedrick D. Kagy Life Achievement Award from the International
Graphic Arts Education Association (IGAEA); the 2006 Michael H.
Bruno Award from the Technical Association of the Graphic Arts
(TAGA); and the 1991 Education Award of Excellence from the
Graphic Arts Technical Foundation (GATF). He can be reached at
rycppr@rit.edu

Waubhui Liu, Associate Professor

Wuhui Liu is an associate professor at
school of Printing and Packaging, Wuhan
University where he teaches courses
relating to printing color science, prepress,
and printing materials. His research
focuses on color management and quality
control. He received his B.A. in printing
science from Wuhan Technical University
of Surveying and Mapping, China in 1988,
M.S. in mapping Science from the same
university in 1995, and Ph.D. in publishing science from Wuhan
University in 2006. He has published over 30 technical papers and
six books about graphic arts. He is a visiting scholar in RIT’s School
of Printing Media in 2007. He can be reached at: wuhui_liu@163.
com

Fred Hsu, Color Specialist

Fred works for RIT’s Printing Applications
Laboratory as a Color Specialist. Upon
receiving a Master of Arts in Graphic
Communications  from  New  York
University in 2002, he started a second
Master’s  degree from RIT’s Printing
Technology Program. Fred is involved in
research related to process control and
color management. He has extensive
experience in coding macros that enable
Excel spreadsheets to perform calculations and graphics for color
analysis and process control applicatins. Fred can be reached at:
cyhter@rit.edu.

The Test Targets 7.0 Team

Franz Sigg, Senior Research Associate

Franz Sigg is a teacher, researcher, and

thesis adviser to students at the School

of Print Media at Rochester Institute of

Technology. He holds a Master of Science

degree in Printing Technology from RIT.

He has spent much of his professional

career developing, testing, and producing

both analog and digital test targets for

the graphic arts industry. Currently, he is

involved in designing and programming

PostScript targets for digital imaging systems. Recently Franz
developed specialized test targets and test forms to help optimize
and calibrate CTP systems, particularly for newsprint. Franz was the
1998 TAGA Honors Award recipient. He can be reached at: fxsppr@
rit.edu.

Steve Suffoletto, Senior Training Specialist

Steve Suffoletto is a Senior Training

Specialist for RIT’s Printing Application

Laboratory since 1997. He trains and

consults in a variety of subjects for public

seminars at RIT and custom programs at

the customer’s site in the United States

and Canada as well as Mexico, Barbados,

Australia, France, England, Belgium,

Trinidad, and Guatemala. Steve attended

RIT and received his degree in 1981 from

the School of Printing Management and Sciences. Steve has over
31 years of diversified industry experience and worked 10 years
in production and quality management for sheetfed commercial,
cosmetic folding carton packaging, and paperback book printers.
Steve is a frequent speaker at tradeshows and conference across the
country, especially Graph Expo in Chicago.

Arvind Karthikeyan, Graduate Student

Arvind Karthikeyan is a graduate student

from the School of Print Media, RIT,

specializing in color and imaging

sciences. His areas of interest include

inkjet proofing, softproofing and color

management. Arvind has earned a Bachelor

of Engineering in Printing Technology from

Anna University, Chennai India. His paper

on ‘Nanolithography’ was published

in the 2007 RIT TAGA Student Chapter

journal, Homage. He has been working as a lab assistant under
Prof. Chung in the Color Measurement Lab since Winter 2006. He
can be reached at: ask1357@rit.edu
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Editing, Premedia, and Design

Edline M. Chun, Adjunct Faculty

Edline Chun has been a member of the
Adjunct Faculty of the School of Print
Media since 1993. She coordinated
technical publications for the Instruments
Group of Bausch & Lomb, Inc. during its
divestiture period and later supervised
technical publications for the Analytical
Products Division of Milton Roy Company.
She freelances as an editor-writer and can
be reached at emcppre@rit.edu.

Sri Hemanth Prakhya, Graduate Student

Sri Hemanth Prakhya is a graduate student
of the MS in Print Media program at
the School of Print Media, RIT. A PLGA
Scholarship and GEF Resource Center
Scholarship winner for the academic
year 2007-08, he is about to complete
his thesis on spot colors. His research
projects have been extensively based in
PDF & PDF/X workflows. He is also the
production expediter for the Test Targets

7.0 publication. Prakhya holds a degree in Bachelor of Technology
in Mechanical - Production Engineering from Jawaharlal Nehru
Technological University, Hyderabad, India. He had worked as a
graphic designer for 5 years extensively in print applications; this
experience led him to pursue higher studies in the field of printing.
He can be reached at sreehemanth@gmail.com

Drake Yang, Graduate Student

DrakeYang is a graduate student of the MFA
in Computer Graphics Design program
at RIT. He is also a web designer for
Gravure Research at RIT and responsible
for graphic design and new website of
Gravure program, Color Management
Systems, and Test Targets. Currently; he is
involved in research related to interactive
multimedia especially in Flash game
design and user interface. Drake can be

reached at: www.drakeyang.com
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Michael Riordan, Assistant Professor

Michael Riordan is an Assistant Professor
at RIT’s School of Print Media where
he teaches coursework relating to
color, premedia, and print production
workflows. Through his research at
RIT, he has specialized in streamlining
workflow practices and works closely
with publishers, print service providers,
and creative agencies to help assess and
optimize their production environments.

Michael holds a Master of Science in Graphic Arts Systems from the
Rochester Institute of Technology. He can be reached at: mprppr@

rit.edu.

Sunchut Jongcharoensiri, Graduate Student

Sunchut Jongcharoensiri is a graduate
student in the School of Multidisciplinary
Studies at the Rochester Institute of
Technology, since September 2006.
His major concentration is printing
technology, while business management
is his minor concentration. Sunchut has
worked at Pongsilp Plastic Co., Ltd.,
a flexible packaging manufacturer in
Bangkok, Thailand, for two years. He was

responsible for non-paper gravure printing such as hygienic LLDPE
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